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This chapter gives a brief, conceptual overview of the procedures for installing Oracle's Essbase®
Integration Services.

Integration Services Installation Workflow
Use the following workflow for installing Integration Services, configuring data sources, creating
an OLAP Metadata Catalog, and setting up the sample application:

1. Review Hyperion Installation Start Here guide.

2. Prepare to install: Verify that you have the necessary software product components and that
the server and client computer systems on which you will install Integration Services meet
system requirements. Check for any migration issues. Install Oracle's Hyperion® Essbase®
– System 9, if necessary, and register the Integration Services software.

3. Install the server component: Install Essbase Integration Server.

4. Install the client component: Install Essbase Integration Services Console.

5. Configure data sources: On the computer running Integration Server, create Open Database
Connectivity (ODBC) connections to the relational data sources that you will use for creating
OLAP models and metaoutlines with Integration Services.

6. Create an OLAP Metadata Catalog: Use Integration Services Console to automatically create
an OLAP Metadata Catalog for native environments, or use the SQL scripts provided to
manually create a catalog for Unicode environments.

7. Set up the sample applications (optional): Use Integration Services Console to create the
sample applications automatically, or use the scripts provided to create the sample
applications manually. Both methods can be used to create a sample database, a sample
OLAP Metadata Catalog, a sample OLAP model, and a sample metaoutline. The manual
creation method can be used to create a Hybrid Analysis-enabled sample application or a
Unicode-enabled sample application.

Figure 1 is a graphical representation of the Integration Services workflow.
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Figure 1 Workflow for Installing Integration Services

Verifying Product Contents
Before installing Integration Services, ensure that you have all the following product
components:

● The compressed software ZIP file or DVD that contains the Integration Services product
family software: Integration Services Console and Integration Server

● The compressed documentation ZIP files or DVD containing the readme.htm file and the
following PDF documentation (contained in the Installation Documentation ZIP file and
Product Documentation ZIP file located in the \ais\docs\directory of the product DVD):

❍ Essbase Integration Services Information Map, listing the documentation available with
the release and where to access it

❍ Essbase Integration Services New Features, describing new features

❍ This book, the Essbase Integration Services Installation Guide

❍ Essbase Integration Services ODBC Support Matrix, containing a list of all Open Database
Connectivity (ODBC) and Java Database Connectivity (JDBC) drivers supported by
Integration Services

❍ Essbase Integration Services Data Preparation Guide, providing information about
understanding and defining your business needs and about properly preparing the data
sources that you have available

❍ Essbase Integration Services System Administrator's Guide, describing how to use
Integration Server, OLAP Metadata Catalog, and Integration Services Shell, how to
troubleshoot ODBC and server connections, and where to find error message
information.
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❍ Essbase Integration Services OLAP Model Document Type Definition, describing in detail
the XML document type definitions of the OLAP model.

❍ Essbase Integration Services OLAP Metaoutline Document Type Definition, describing in
detail the XML document type definitions of the OLAP metaoutline.

Note:

Integration Services online help, providing procedural and conceptual information, as
well as dialog box help and a glossary, is available in the Product Documentation ZIP
file and is also accessible from Integration Services Console after the product is installed.

Determining Product Component Configuration
Integration Services includes software components that can run on a single computer or on
multiple computers. Before installing the product, determine where you will install each of the
components. Figure 2 illustrates the components of Integration Services with various possible
configurations.

Figure 2 Configuring the Integration Services Product Family
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The server components illustrated in Figure 2 can be distributed across additional computers.
The Essbase Server component and the relational database each can be installed on a separate
computer. The Integration Server component, ODBC drivers, and, if required, the database
client software for the relational database, however, must be installed on a single computer.

Note that for Oracle RDBMSs, you can use Oracle Call Interface (OCI) and connect directly to
the database. No ODBC drivers are necessary.

12 Overview
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This chapter provides the following information about installing, configuring, and setting up
Integration Services.

Start Here
The following table lists the high-level steps required to install and configure multiple Hyperion
products. Review these steps first, before you begin the installation process. For detailed
information, refer to the component user interface and related documentation listed next to
each step. Following these steps in the sequence listed will help to ensure trouble-free installation
of all Hyperion products.

Hyperion no longer ships or requires Oracle's Hyperion® License Server™ (or standalone license
files) for use with Hyperion products.

To ensure compliance with your license agreement, Hyperion recommends that you implement
an auditing process. In addition, during product configuration with Oracle's Hyperion®
Configuration Utility™, you activate only the features you purchased. For more information,
see “Hyperion License Compliance” in Hyperion Installation Start Here.

Step Instruction Product Component Documentation

1 Install Oracle's Hyperion®
Shared Services™ and configure
the Shared Services application
server and RDBMS.

Shared Services installer

Hyperion Configuration Utility™

Hyperion Shared Services
Installation Guide

2 Configure Shared Services to
authenticate user names that are
stored externally in LDAP, Active
Directory, or Windows NT LAN
Manager, enabling single sign-
on.

Shared Services External
Authentication Configuration
Console

Hyperion Shared Services
Installation Guide

3 Install Hyperion products. Hyperion product installers Product installation guides

Start Here 13



Step Instruction Product Component Documentation

4 Activate and configure Hyperion
products and register them with
Shared Services. You can
configure multiple products at
one time, if they are installed on
the same computer.

Hyperion Configuration Utility Product installation guides

5 Create projects, add
applications to projects, and
provision users for applications.

Shared Services User
Management Console™

Hyperion Shared Services User
Management Guide

Note:

Integration Services is an optional, separate feature of Essbase. Product activation, Shared
Services installation, registration, and related setup tasks are performed through Essbase.

Integration Services Installation Checklist
This checklist contains steps required for a successful installation of Integration Services. Page
numbers refer to this installation guide unless otherwise noted. If you are upgrading, see
Chapter 11, “Upgrading Integration Services”.

Before you begin the installation process, ensure that you meet the hardware and software system
requirements contained in the Chapter 3, “Planning the Installation.” For information on
supported open database connectivity (ODBC) drivers and supported servers, see the Essbase
Integration Services ODBC Support Matrix.

Integration Services INSTALLATION TASKS REFERENCE

 1. Verify that you are ready to install Integration Services:

● You have all necessary product components

● You server and clients meet system requirements

● You have the required Open Database Connectivity (ODBC)
driver for your data source and operating system platform.

● You have installed Essbase, if necessary.

2. If you have an earlier version of Integration Services installed,
verify that you are ready to upgrade to the current release.

3. Install the server (Essbase Integration Server).

4. Install the client (Essbase Integration Services Console).

Chapter 1, “Overview”

Hyperion Installation Start Here

Essbase Integration Services ODBC Support Matrix

Chapter 11, “Upgrading Integration Services”

Chapter 4, “Installing Integration Services”

CONFIGURATION TASKS REFERENCE

 1. Create an OLAP Metadata Catalog automatically or manually.

● To create an OLAP Metadata Catalog automatically, use
Essbase Integration Services Console.

● To create an OLAP Metadata Catalog manually, use the
provided scripts.

Chapter 7, “Creating, Upgrading, and Deleting OLAP Metadata
Catalogs”

Chapter 8, “Setting Up the Sample Applications”
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● Microsoft Active Directory (MSAD)

Shared Services writes your configuration information
to a central XML-based security configuration file that
is generated by Shared Services. <> references the
security configuration file for single sign-on of external
and remote users.

2. Set up the sample application automatically or manually
(optional).

● To set up the standard sample application automatically,
use Integration Services Console.

● To set up the standard sample application manually, use
the provided scripts.

● To set up the Hybrid Analysis sample application, use the
provided scripts.

● To set up the Unicode sample application, use the
provided scripts.

Integration Services Installation Checklist 15
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Planning the Installation

In This Chapter

Preparing to Install Integration Services ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .17

ODBC and JDBC Connectivity .. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .18
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Preparing to Install Integration Services
Before installing Integration Services, verify that you have all product components necessary for
the software and ensure that your computer systems meet the system requirements for the
software. In addition, if you are upgrading a previous release of Integration Services, assess the
migration issues before beginning the upgrade (see Chapter 11, “Upgrading Integration
Services”).

Note:

Before installing Integration Services, review Hyperion Installation Start Here.

Supported Releases of Essbase
The current release of Integration Services supports the more recent versions of previous  Essbase
releases. To use the latest features of Integration Services, however, you must install the latest
release of Essbase. For detailed information on supported Essbase releases, see the chapter
“Release Compatibility” in Hyperion Installation Start Here.

Third-Party Platform Software Compatibility
Subsequent maintenance releases and service packs for third-party platform software may be
used where the vendor asserts backward compatibility. Please be aware, however, that although
these assertions are made in good faith, certain incompatibilities may exist. In the event that an
incompatibility is identified, Hyperion may experience a delay in reproducing and fixing
resultant issues for the affected versions.
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System Requirements
Complete details on system requirements for Integration Services client and server software are
found in the chapter “System Requirements” in Hyperion Installation Start Here. System
requirements for other Hyperion products can be found in the same location.

ODBC and JDBC Connectivity
This section describes the supported ODBC and JDBC drivers for Integration Services.

For server installations, confirm that you have ODBC drivers that are compatible with both the
relational database and the operating system of the server on which Integration Services is
installed. Integration Services includes ODBC drivers from DataDirect (MERANT). However,
in some cases, it is recommended that you use the ODBC drivers provided by your relational
database vendor.

Note:

For information on ports, see Hyperion Installation Start Here.

ODBC Drivers
Integration Services supports Oracle Call Interface (OCI) direct connection and vendor-
supplied drivers from Oracle, Microsoft SQL Server, and Teradata.

Note:

Unless otherwise noted, client software is not required for the database server. ODBC drivers
used with Integration Services must be thread-safe. HP-UX requires kernel-threads. Solaris
requires Solaris threads. IBM AIX requires kernel-threads with pthread API.

Relational
Database

Windows Solaris AIX HP-UX Red Hat Linux

IBM DB2 UDB
9.1

IBM DB2 UDB
8.2

IBM DB2 UDB
8.1.7a

IBM DB2 v7x for
z/OS*

DataDirect Driver
5.2

DataDirect Driver
5.2

DataDirect
Driver 5.2

DataDirect
Driver 5.2

DataDirect Driver
5.2

Oracle 10g
(10.1.0.3)

DataDirect Driver
5.2

DataDirect Driver
5.2

DataDirect
Driver 5.2

DataDirect
Driver 5.2

DataDirect Driver
5.2
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Relational
Database

Windows Solaris AIX HP-UX Red Hat Linux

Oracle 10g
(10.1.0.5)

Oracle 9i
(9.2.0.1)

Microsoft SQL
Server 2005
SP1

SQL Server 2005
ODBC native
driver†

DataDirect Driver
5.2

DataDirect
Driver 5.2

DataDirect
Driver 5.2

DataDirect Driver
5.2

Microsoft SQL
Server 2000
SP3a

SQL Server 2000
ODBC native
driver‡

DataDirect Driver
5.2

DataDirect
Driver 5.2

DataDirect
Driver 5.2

DataDirect Driver
5.2

MySQLde MySQL
Connector/
ODBC 3.51 x

MySQL
Connector/
ODBC 3.51 x

Not supported Not supported MySQL
Connector/
ODBC 3.51 x

Teradata
V2R5.1

Teradata 3.05
ODBC

Teradata 3.05
ODBC

Teradata 3.05
ODBC

Teradata 3.05
ODBC

Teradata 3.05
ODBC

Teradata
V2R6.0 and
laterf

Teradata 3.06
ODBC

Teradata 3.06
ODBC

Teradata 3.06
ODBC

Teradata 3.06
ODBC

Teradata 3.06
ODBC

*IBM DB2 v7x for z/OS is supported as data source, but not for OLAP Metadata Catalog.
†Microsoft SQL Server 2005 driver must be obtained from Microsoft.
‡SQL Server 2000 driver must be obtained from Microsoft.
dMySQL is supported for OLAP Metadata Catalog, but not as a data source.
eMySQL ODBC drivers must be obtained from MySQL.
fTeradata ODBC drivers must be obtained from NCR corporation.

JDBC Drivers
If you are using Teradata as an Integration Services data source, JDBC drivers are required. You
must obtain the drivers separately from Teradata Corporation.

Note:

JDBC drivers are not supported for Integration Services on the 64-bit Itanium platform.

Relational Database JDBC Driver (Windows)

Teradata V2R5.1* 03.01.00.10

03.03.00.06

03.04.00.03

Teradata V2R6.0 and later† 03.01.00.102

03.02.00.03

*Obtain the driver separately from the Teradata web site
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†Obtain the driver separately from the Teradata web site

Member Load Memory Requirements

Platform Windows UNIX

32–bit 10 MB + (700 Bytes * number of members) 50 MB + (700 Bytes * number of members)

64–bit 20 MB + (900 Bytes * number of members) 70 MB + (900 Bytes * number of members)

Hybrid Analysis, Advanced Relational Access, and Drill-through
Table 1

Relational Database Server Hybrid Analysis Support Advanced Relational Access
Support

Drill-through

IBM DB2 UDB 8.2 Yes Yes Yes

IBM DB2 UDB 8.17a Yes Yes Yes

IBM DB2 v7x for z/OS Yes Yes Yes

Oracle 10.1.0.3 Yes Yes Yes

Oracle 10g — 10.1.0.2 Yes No Yes

Oracle 9i — 9.2.0.1 Yes Yes Yes

Microsoft SQL Server 2005 SP1 Yes Yes Yes

Microsoft SQL Server 2000 SP3a Yes Yes Yes

MySQL No No No

Teradata V2R5.1 and later Yes Yes Yes

Teradata V2R6.0 and later Yes Yes Yes

Clients Outside Your Firewall
In some cases, Integration Services Console is used on a client computer that is outside the
firewall for your network, and the console requires access to Integration Server and Essbase
Server located inside the firewall for your network. In these cases, you must log on to Essbase
Server with a name that can be used by both the client system and Integration Server when
communicating with Essbase Server.

Problems arise when you attempt to log on using the external IP address of the computer running
Essbase Server. Integration Server cannot use the external IP address to communicate with the
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computer running Essbase Server because both are inside the firewall. Administrators can solve
this problem by defining an alias for the Essbase Server computer that is usable from both sides
of the firewall.
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This chapter describes the procedures for installing the Integration Services software server
components and client components.

The server components include Integration Server; Integration Services Shell; OLAP Metadata
Catalog scripts; sample application scripts, batch files, and data; and ODBC drivers.

Installing Server Software on Windows Systems
The following procedure describes how to install the server software on a PC that is running
Windows. The server software is contained in the Integration Services compressed software ZIP
file or on the installation DVD.

Caution!

You must have system administrator privileges to install on the Windows platforms. If you do
not have appropriate privileges, parts of the installation will fail.

➤ To install server software on Windows systems:

1 Perform the steps in “Preparing to Install Integration Services” on page 17.

2 Close all applications.

3 Run setup.exe

If you download the compressed software ZIP file, the setup.exe file launches automatically
after you unzip the software file.

Installing Server Software on Windows Systems 23



If you install from the Integration Services DVD, insert the DVD into the DVD-ROM drive and
from the first screen, select Integration Services. The installation program starts automatically.
You can also run setup.exe from the ais directory of the DVD.

4 Select the language to be used for the installation and click OK.

The default language is English.

5 Select the country to be used for the installation and click Next.

The default country is the United States.

6 Click Next in the installation program welcome screen.

7 Choose the directory in which you want to install Integration Services.

The default directory is C:\Hyperion\AIS.

Note:

If you do not select the default directory, documentation links may not function.

8 Choose the directory in which you want to install the common components (HYPERION_HOME).

The default directory is C:\Hyperion.

Note:

After your installation is complete, you cannot move the common components from
HYPERION_HOME. If you want to move the common components to an alternate location
because of disk space issues or because of other reasons, you should uninstall the suite of Essbase
products and reinstall them after moving the common components to an alternate directory.

9 Select the setup type appropriate to your environment:

● Typical. Integration Services is installed with the default set of features. This option is
recommended for most users. It installs all features of Integration Services:

❍ Server

❍ Console

❍ Documentation

❍ Sample Applications

❍ DataDirect ODBC 5.0 Driver Component

● Custom. Integration Services is installed with the features that you select. This option is
recommended for advanced users.

10 Review the summary information to verify that you are installing the appropriate features and that you are
installing to the appropriate directory, and click Next.

11 After Integration Services is installed, click Finish to exit the installation program.

Before you use Integration Services, restart the computer to apply the changes that setup has
made to the environment.
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Mapping JDBC Data Sources (Teradata and Oracle Users
Only)
Teradata and Oracle OCI users must map a JDBC data source to a relational database in the 
ais.cfg file in order to use the XML Import/Export feature of Integration Services. Teradata
requires JDBC Type 3 and Oracle OCI requires JDBC Type 4.

To map a data source, edit the ais.cfg file (located in ISHOME\bin) using any text editor. If
the ais.cfg file does not exist, use a text editor to create and edit it, then save it in ISHOME
\bin.

Multiple OLAP Metadata Catalogs can be mapped under the [JDBC DSN] heading. If you want
to comment out certain data sources in a list of data sources, insert the pound sign (#) as the
first character in a line. (See the data source mapping examples that follow.)

The following syntax provides usage guidelines for editing ais.cfg to connect to a Teradata or
an Oracle relational data source.

Syntax

[JDBC DSN]<Teradata ODBC DSN>:<Gateway Host>:<Port # on Gateway>/
<Server Host>oracle:<tnsname | oname>:<host name>:<port #>:<SID>

Command Description

[JDBC DSN] (Required) Available by default

For Teradata:

Teradata ODBC DSN The name of the Teradata data source used as the OLAP Metadata Catalog in Integration
Services

Gateway Host The host on which the Teradata Gateway program is running

Port # on Gateway Port number of the Gateway host

Server Host The host on which the Teradata server resides

For Oracle:

tnsname The name of the Oracle Net Service Name (found in $ORACLE_HOME/network/ admin/
tnsnames.ora) used as the OLAP Metadata Catalog in Integration Services

See “Mapping JDBC Data Sources (Teradata and Oracle Users Only)” on page
25on page 26 for an example of a Net Service Name definition.

oname The Schema Name used to connect to an Oracle database if you are using onames instead
of tnsnames

This is the database identifier that you use when you connect to the database using SQL*Plus.

host name The host on which the Oracle server is installed or running

port # Port number of the host on which the Oracle server is configured

SID The server identifier for Oracle on host <host name>
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In the following examples for mapping a JDBC data source for Teradata and Oracle, note that
the pound sign (#) at the beginning of a line indicates that the line has been commented out.

Example of JDBC Type 3 Settings for Teradata

[JDBC DSN]td_catalog_dsn:labmachine1:6063/teradataServer
#tbc_md:labmachine1:6063/tera1td_tbc_md:labmachine1/
6063:tera1

Example of JDBC Type 4 Settings for Oracle

[JDBC DSN]oracle:ora_tbc_md:labmachine2:1521:orasid
#oracle:tbc_md:labmachine2:1521:orasid

When using Oracle with tnsnames, if the definitions for tnsname, host name, port #, and SID
elements do not match the corresponding elements of a Net Service Name stanza in the
tnsnames.ora file, a Java environment error will be the result. The preceding JDBC settings
example is built using the elements in the following tnsnames.ora stanza:

ora_tbc_md =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = labmachine2)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVICE_NAME = orasid)
    )
  )

When using Oracle with onames, in the example above, ora_tbc_md is the Schema Name used
to connect to an Oracle database. This is the database identifier you use when you are connecting
to the database using SQL*Plus.

Completing Additional Steps on Windows Systems
After installing the server software on Windows systems, you must perform additional steps
before you can use Integration Services:

● Install the Integration Services Console client software (optional, if not already installed
when you installed the server).

See Chapter 6, “Post-Installation Tasks.”

● Using ODBC, configure a data source name for both an OLAP Metadata Catalog database
and a data source database.

See Chapter 5, “Configuring Data Sources.”

Note:

If you are using IBM DB2 OS/390, after you configure a data source name for your source
data, you must add an entry for the new data source name to the ais.cfg file.

● Create an OLAP Metadata Catalog.
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See Chapter 7, “Creating, Upgrading, and Deleting OLAP Metadata Catalogs.”

● Verify that the Windows Schedule service is running if you want to schedule jobs.

See “Starting the Windows Task Scheduler Service” on page 110.

Installing Client Software
The following procedure describes how to install client software from the compressed software
ZIP file or the Integration Services DVD to a computer running the Windows platform.

Caution!

You must have system administrator privileges to install on Windows. If you do not have system
administration privileges, parts of the installation will fail.

➤ To install client software on Windows systems:

1 Perform the steps in “Preparing to Install Integration Services” on page 17.

2 Close all applications.

3 Run setup.exe

If you download the compressed software ZIP file, the setup.exe file launches automatically
after you unzip the software file.

If you are installing from the Integration Services DVD, insert the DVD into the DVD-ROM
drive and from the first screen, select Integration Services. The installation program starts
automatically. You can also run setup.exe from the ais directory of the DVD.

4 Select the language and country to be used for installation and click OK.

The default language is English. The default country is the United States.

5 Click Next in the installation program welcome screen.

6 Choose the directory in which you want to install Integration Services.

The default directory is C:\Hyperion\AIS.

Note:

If you do not select the default directory, documentation links may not function.

7 Choose the directory in which you want to install the common components (HYPERION_HOME).

The default directory is C:\Hyperion.

8 Select the setup type appropriate to your environment:

● Typical—Integration Services is installed with the default set of features. This option is
recommended for most users.
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● Custom—Integration Services is installed with the features that you select. This option is
recommended for advanced users.

9 In the Product Installation hierarchy, select Console.

10 Review the summary information to verify that you are installing the appropriate features and click Next.

11 Review the installation path to verify that you are installing to the common directory and click Next to install
Integration Server.

12 After Integration Services is installed, click Finish to exit the installation program.

Before you use Integration Services, you must restart the computer to apply the changes
setup made to the environment.

Hyperion Home for Windows
When multiple Hyperion products are installed on one computer, common internal and third-
party components are installed to a central location, called Hyperion Home. The Hyperion Home
location is defined in the system environment variable called HYPERION_HOME.

Hyperion Home Location
The default location for Hyperion Home is C:\Hyperion. When you install, the installer
searches for the HYPERION_HOME environment variable on the computer to which you are
installing.

If the Hyperion Home location was previously defined for another Hyperion product, the
installation uses the previously defined location. The location cannot be changed through the
installer.

If the current installation is the first Hyperion installation on the computer, you can specify the
location during installation.

Files Installed in the HYPERION_HOME Directory
Various files are installed in the HYPERION_HOME\common directory by a default installation of
Shared Services. Some common components, and thus some files and folders, are optional and
may not be installed.

Table 2 Common-Component Folders Created in the Common Directory 

Folder Contents

appServers Application server files

CLS License services APIs

config Oracle's Hyperion® Configuration Utility™ files

CSS Files to support Hyperion external authentication
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Folder Contents

Docs Product documentation files

EssbaseJavaAPI Java driver used when embedding Essbase in other applications

EssbaseRTC Essbase runtime client used when embedding Essbase in other applications

httpServers Apache web server files for batteries included installation

HyperionLookAndFeel Installer user interface files

JakartaCommons Common development library files

JavaMail Files to support sending e-mail via Java

JCE JCE files for encryption, key generation and agreement, and MAC

JDBC JDBC files

JRE Java Runtime Environment files

lib common internal library files

loggers Files for external authentication logging

ODBC ODBC drivers

Opatch Oracle patching tool files; for future use

PERL Scripting language files

SAP SAP files

SharedServices Supporting files for Shared Services

utilities Utilities to change the location of Hyperion Home and export, import, or validate
provisioning data

validation Not used in this release

velocity Not used in this release

XML Common XML components

Changing the Hyperion Home Location
After Hyperion Home is defined through the product installation, you can run a migration utility
to change the Hyperion Home location.

The migration utility moves the files installed in Hyperion Home to the new location and updates
the value of the HYPERION_HOME environment variable.

Hyperion Home Migration Utility is provided with the Oracle's Hyperion® Shared Services
installation.
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➤ To change the Hyperion Home location:

1 Launch the migration utility:

● Choose a method:

❍ Select Start > Programs > Hyperion > Foundation Services > Home Migration
Utility.

❍ Double-click the run.exe file from <HYPERION_HOME>\common\utilities
\HyperionHomeTool\9.3.1\bin.

❍ From a Windows console, change to <HYPERION_HOME>\common\utilities
\HyperionHomeTool\9.3.1\bin. Then type run.exe -console.

2 Step through the screens, and when prompted, enter the Hyperion Home location or click Browse to navigate
to the preferred location.

Do not choose a HYPERION_HOME location that contains a space character. For example, C:
\Program Files is not acceptable.

Running Silent Installations
If you want to install Integration Services on multiple computers using the same installation
options, you can record your installation settings and then run a "silent" installation from the
command line. Silent installations automate the installation process so that you can install
Integration Services without specifying installation settings each time.

To record your installation settings, you first create a "response" file and then run the regular
installation to record your settings in the response file. Then, when you run the silent installation
from the command line, the response file is used to set the same installation options as the regular
(nonsilent) installation.

➤ In order to run the Integration Services install in silent mode:

1 Run the installer in record mode to record the selection in an output file:

-> setup.exe -options-record <responsefilename>

2 Use the options file to run the installer in silent mode:

-> setup.exe -options "<responsefilename>" -silent

Completing the Installation
To complete the installation of Integration Services, see Chapter 4, “Installing Integration
Services,” Chapter 5, “Configuring Data Sources,” and Chapter 7, “Creating, Upgrading, and
Deleting OLAP Metadata Catalogs.” To work with the sample application, see Chapter 8, “Setting
Up the Sample Applications.”

For detailed information about installed files, directories, environment changes made by the
installation program, and uninstalling the software, see Chapter 9, “Completing Advanced
Installation Tasks,” and Chapter 10, “Uninstalling Integration Services.”
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Tip:

During installation, configuration, and testing, keep a list of all user names and passwords that
you use to create or modify the system, including the applications with which they are associated
and their purpose.
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5
Configuring Data Sources
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To create OLAP models or build metaoutlines, you must connect Integration Services to a
database that contains metadata (the OLAP Metadata Catalog database) and to a database in
which needed users’ data is stored (the Data Source database). To make these connections, you
must configure a data source name for an OLAP Metadata Catalog database and a Data Source
database. You do this by mapping a supported Open Database Connectivity (ODBC) driver to
each database.

Note:

You are not required to use two different databases for your Data Source database and OLAP
Metadata Catalog database. Additionally, you are not required to use two different data source
names to connect to the Data Source database and OLAP Metadata Catalog database if the two
databases reside in the same database.

About Data Source Configuration
In Integration Services, a data source name must be configured for the source database or flat
files that contains users’ data (the Data Source database). A data source must also be configured
for the relational database that contains the OLAP Metadata Catalog. Databases, including an
OLAP Metadata Catalog, can run on any supported platform, provided that you have the ODBC
driver and, in some cases, the database client software needed to access them.

The Integration Services installation program installs DataDirect ODBC driver files that you use
to configure data source names for both the Data Source database and OLAP Metadata Catalog
database.

If database client software is required, the relational database management system (RDBMS)
should include one of the database clients listed in Essbase Integration Services ODBC Support
Matrix. If your configuration requires database client software, ensure that the versions of the
database client and the RDBMS are compatible.
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This chapter provides information on how to configure ODBC drivers. For information on how
to install and configure database client software, see the RDBMS documentation.

Note:

Integration Services does not support data source table names and column names that contain
spaces or special characters, such as a period (.). See the Essbase Integration Services System
Administrator's Guide for a complete listing of the unsupported characters.

On Windows, use the ODBC Administrator to configure ODBC data sources. All ODBC data
source names are configured only on the computer that runs Essbase Integration Server.

Note:

If a supported ODBC driver is already mapped to a Data Source database, you do not need to
map it again. In this case, you need to map a supported ODBC driver only to the OLAP Metadata
Catalog database.

If you are using Oracle OCI direct connection, you connect Integration Services to an OLAP
Metadata Catalog database and to a Data Source database when you access the databases in
Integration Services Console. This process is described in “Connecting to Integration Server”
on page 54 and “Connecting to Data Sources” on page 57.

Server and Client Software and ODBC Connections
Integration Server runs on Windows 2000, Windows XP, Windows 2003, AIX, HP-UX, Solaris,
or Red Hat Enterprise Linux. You must install Integration Server software, including ODBC
drivers, and if required, database client software on the Integration Server computer.

Integration Services client software runs on Windows 2000, Windows XP, or Windows 2003.
You must install the Integration Services Console software on Integration Services client
computers.

Configure the ODBC connections to the Data Source database and the OLAP Metadata Catalog
database only on the computer running Integration Server. You do not need to configure ODBC
connections on Integration Services client computers.

If you are using Oracle OCI direct connection, you connect Integration Services to both an OLAP
Metadata Catalog database and a Data Source database when you access the databases in
Integration Services Console. This process is described in “Connecting to Integration Server”
on page 54 and “Connecting to Data Sources” on page 57.

Figure 2 on page 11 illustrates a configuration of Integration Services components.

For more information on configuring Integration Services product family components, see
“Determining Product Component Configuration” on page 11.
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Supported ODBC Drivers
For a complete list of supported ODBC drivers by platform, see the Essbase Integration Services
ODBC Support Matrix, located in the ISHOME\docs directory.

For detailed information on the DataDirect Wire Protocol drivers provided with Integration
Services, see the DataDirect Connect ODBC Reference in PDF format in the HYPERION_HOME
\common\ODBC\Merant\5.0\docs directory. Use Adobe Acrobat Reader, which is available
for installing from the ais/docs/viewer directory of the DVD (or available for free download
at www.adobe.com) to read the PDF files.

Configuring Data Source Names on Windows Systems
To configure data source names on Windows systems, you must start ODBC Administrator and
then map an ODBC driver to one or more relational databases or flat file data sources that you
will use for creating and storing OLAP models and metaoutlines. Run the ODBC Administrator
utility from the Windows Control Panel.

Note:

Integration Services does not support data source table names and column names that contain
spaces or special characters, such as a period (.). See the Essbase Integration Services System
Administrator's Guide for a complete listing of the unsupported characters.

The procedures in the following sections show you how to configure data source names to create
connections to databases. The examples in the procedures use a database named TBC as the
sample Data Source database and a database named TBC_MD as the sample OLAP Metadata
Catalog database.

For each site-specific data source name that you configure, obtain the following information
from your database administrator:

● The name of the relational database or flat file data source for which you want to configure
a data source name

For example, in the sample application, TBC is the name of the Data Source database;
TBC_MD is the name of the OLAP Metadata Catalog database.

● IP address or name of the computer on which the database tables are stored

You can enter either an alphabetic computer name (for example, sequoia), or an IP address
(for example, 172.0.0.125).

In the sample application, if you are configuring a data source name for the TBC database,
use the IP address of the computer where the TBC database tables are stored. If you are
configuring a data source name for the TBC_MD database (the sample OLAP Metadata
Catalog database), use the IP address of the computer where the TBC_MD tables are stored.

● Port number on which your database listens
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For clarity in presenting the sample application in Integration Services Console, the sample
Data Source database and sample OLAP Metadata Catalog database are two separate
databases that use two different data source names.

If your data is stored in a relational database, you are not required to use two different
databases for your Data Source database and OLAP Metadata Catalog database.
Additionally, you are not required to use two different data source names to connect to your
Data Source database and OLAP Metadata Catalog database if all the tables reside in the
same database.

If your data is stored in one or more flat files, you must still use a relational database when
setting up your OLAP Metadata Catalog database.

Note:

If you plan to use flat files as data sources, you must configure their Data Source Name
(DSN). See “Configuring the DataDirect Text Driver” on page 41 for detailed instructions.

Note:

If you are using Oracle OCI direct connection, you do not need to configure data sources.
You connect Integration Services to relational data sources when you access them in
Integration Services Console. This process is described in “Connecting to Integration Server”
on page 54 and “Connecting to Data Sources” on page 57.

Accessing ODBC Data Source Administrator
For any RDBMS, you must access the Windows ODBC Data Source Administrator to begin the
data source name configuration process.

➤ To access the Administrator:

1 On the Windows desktop, select Start > Settings > Control Panel to open the Control Panel window.

2 In the Control Panel window, double-click the Administrative Tools icon, and then double-click the Data
Sources (ODBC) icon to open the ODBC Data Source Administrator dialog box.

3 In the ODBC Data Source Administrator dialog box, click the System DSN tab.

Configuring DataDirect Wire Protocol Drivers
Use the following procedures to configure a data source name for your Data Source database
using a DataDirect Wire Protocol driver for DB2, Informix, Oracle, or Sybase. Then repeat the
procedure to configure a data source name for the relational database that you want to use as
your OLAP Metadata Catalog database.

Before beginning the configuration procedure, perform the procedure in “Accessing ODBC Data
Source Administrator” on page 36.
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Note:

You may repeat the configuration procedure to create any number of data source names to
relational Data Source databases or OLAP Metadata Catalog databases.

➤ To configure a data source name:

1 Click Add to open the Create New Data Source dialog box.

2 In the driver list box of the Create New Data Source dialog box, select the appropriate Wire Protocol driver
for your RDBMS, and click Finish.

The Wire Protocol Driver Setup dialog box for your RDBMS is displayed.

3 In the Data Source Name text box, type the name that you want to use for this data source connection.

In the sample application, TBC is the data source name used to connect to the Data Source
database called TBC; TBC_MD is the data source name used to connect to the sample OLAP
Metadata Catalog database called TBC_MD.

4 Optional: If you want to record a description, in the Description text box, type a description that indicates
how you use this data source name.

For example, you might type the following to describe the My Business database:

Customers, products, markets

You might type the following to describe the sample application database:

Sample relational data source 

You might type the following to describe the sample OLAP Metadata Catalog database:

Sample OLAP Metadata Catalog

5 Make the necessary entries to configure data source names by completing the set of steps appropriate to
your RDBMS.

Refer to the following sections for the specific configuration instructions for your RDBMS:

● “DB2 UDB or DB2 OS/390” on page 38

● “Informix” on page 39

● “Oracle” on page 39

● “Sybase” on page 39

6 Test the connection by following the procedures in “Testing DataDirect Wire Protocol Drivers” on page
40.

When you finish testing, repeat Step 2 through Step 5 to configure a data source name for an
OLAP Metadata Catalog database.
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DB2 UDB or DB2 OS/390

➤ Perform the following steps to configure the Wire Protocol driver for DB2 UDB or OS/390:

1 In the IP Address text box, type the address (either the computer name or the numeric IP address) of the
computer where the database tables are stored.

2 In the Tcp Port text box, type the port number on which the DB2 database server listens.

● If you are using DB2 UDB, the default port number is 50000.

● If you are using DB2 OS/390, the default port number is 446.

3 If you are using DB2 UDB, in the Database Name text box, type the name of the database for which you
want to create this data source name.

4 If you are using DB2 OS/390, perform the following actions:

a. In the Location text box, type the DB2 location name as defined during the DB2 OS/390
installation.

b. In the Collection text box, type the name that identifies a logical group of database objects
(the default is DATADIRECT00).

Note:

For DB2 OS/390, you configure a data source name for the Data Source database only.
You cannot configure a data source name for the OLAP Metadata Catalog database. OLAP
Metadata Catalog functionality is not supported in DB2 OS/390.

To use Integration Services with DB2 OS/390, you must add an entry to the ais.cfg file after
you configure the data source name for the source database. See “Adding a Configuration
File Entry for DB2 OS/390” on page 40 for more information.

5 Click the Bind tab.

6 Accept the default in the Bind tab and click the Create Package button.

For more information about the bind process, see DataDirect Technologies Connect ODBC
Reference. The DataDirect documentation is located in HYPERION_HOME/common/ ODBC/
Merant/5.0/Docs.You can also access the Product Documentation on the DataDirect Web
site at http://www.datadirect-technologies.com.

7 In the Login dialog box, type the user name and password associated with the database for which this ODBC
data source name is being created, and click OK.

A message is displayed informing you that the package was created successfully.

8 Return to Step 6 in “Configuring DataDirect Wire Protocol Drivers” on page 36 to complete the configuration
process.
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Informix

➤ Perform the following steps to configure the Wire Protocol driver for Informix:

1 In the Host Name text box, type the address (either the computer name or the numeric IP address) of the
computer where the database tables are stored.

2 In the Port Number text box, type the port number on which the Informix database server listens.

The default port number for Informix is 1526.

3 In the Server Name text box, type the address, either numerically or by name, of the Informix server as it
appears in the sqlhosts file.

If you do not know this information, contact your Informix database administrator.

4 In the Database Name text box, type the name of the database for which you want to create this data source
name.

5 Return to Step 6 in “Configuring DataDirect Wire Protocol Drivers” on page 36 to complete the configuration
process.

Oracle

➤ Perform the following steps to configure the Wire Protocol driver for Oracle:

1 In the Host text box, type the address (either the computer name or the numeric IP address) of the computer
where the database tables are stored.

2 In the Port Number text box, type the port number on which the Oracle database server listens.

The default port number for Oracle is 1521.

3 In the SID text box, type the name of the database for which you want to create this data source name.

4 Return to Step 6 in “Configuring DataDirect Wire Protocol Drivers” on page 36 to complete the configuration
process.

Sybase

➤ Perform the following steps to configure the Wire Protocol driver for Sybase:

1 In the Network Address text box, type the address (either the computer name or the numeric IP address)
of the computer where the database tables are stored and the port number on which the Sybase database
server listens.

Separate the computer name or IP address and the port number with a comma as shown in the
following examples:

By name: sequoia,4100

Numerically: 172.0.0.125,4100

2 In the Database Name text box, type the name of the database for which you want to create this data source
name.
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3 If you are using a DataDirect Wire Protocol driver for a Sybase relational database server, or a Microsoft SQL
server, you must perform one of the following tasks, depending upon your platform:

● On Windows platforms:

a. Open the ODBC Sybase Wire Protocol Driver Setup dialog box.

b. Select the Advanced tab.

c. Select the Enable Quoted Identifiers option.

The option is deselected by default.

4 Return to Step 6 in “Configuring DataDirect Wire Protocol Drivers” on page 36 to complete the configuration
process.

Testing DataDirect Wire Protocol Drivers

➤ To test a data source name connection:

1 Click Test Connect.

The Login to Wire Protocol dialog box for your RDBMS is displayed.

2 In the User Name and Password text boxes, enter a valid user name and password for this data source
connection, and click OK.

If an error message is displayed, make the necessary corrections, and click Test Connect again.

When no errors occur, a dialog box displays the message, Connection established!

3 In the message dialog box, click OK.

You are returned to the ODBC Wire Protocol Driver Setup dialog box.

4 In the ODBC Wire Protocol Driver Setup dialog box, click OK.

You are returned to the System DSN tab of the ODBC Data Source Administrator dialog box.
The data source name that you entered and the driver that you mapped to the data source name
are displayed in the System Data Sources list box.

5 Repeat Step 1 through Step 5 in “Configuring DataDirect Wire Protocol Drivers” on page 36 to configure a
data source name for an OLAP Metadata Catalog database.

6 When you have completed configuration of all needed data source names, click OK to close the ODBC Data
Source Administrator dialog box.

Adding a Configuration File Entry for DB2 OS/390
If you are using IBM DB2 OS/390, you must add an entry to the ais.cfg file to support
Integration Services functionality. You must add entries for each data source name for DB2 OS/
390 that you have configured.

40 Configuring Data Sources



Note:

For DB2 OS/390, you configure a data source name for the Data Source database only. You
cannot configure a data source name for the OLAP Metadata Catalog database. OLAP Metadata
Catalog functionality is not supported in DB2 OS/390.

➤ To add an entry for DB2 OS/390 to the ais.cfg file: :

1 On the computer running Integration Server, use a text editor to open ais.cfg.

2 Add a new line for DB2 OS/390 using the data source name or names you have configured.

Add separate lines for each data source name configured for DB2 OS/390. The syntax is:

[DS:dsn:390]

For example, using the sample application database, TBC, the following is the entry to the
ais.cfg file:

[DS:TBC:390]

3 Save and close ais.cfg.

Configuring the DataDirect Text Driver
Use the following procedure to configure a data source name for your Data Source database that
consists of one or more ASCII text files using a DataDirect Text driver.

Note:

Integration Services does not support data source table names and column names that contain
spaces or special characters, such as a period (.). See the Essbase Integration Services System
Administrator's Guide for a complete listing of the unsupported characters.

For more information on configuring the ODBC driver settings for text files, see the DataDirect
Connect ODBC Reference PDF file in the $HYPERION_HOME/common/ODBC/Merant/5.0/
docs directory.

Note:

You must complete the steps in “Configuring DataDirect Wire Protocol Drivers” on page 36 to
configure a data source name for the relational database that you want to use as your OLAP
Metadata Catalog database.

Before beginning the configuration procedure, perform the procedure in “Accessing ODBC Data
Source Administrator” on page 36.

➤ To configure a data source name for a flat file data source:

1 Click Add to open the Create New Data Source dialog box.
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2 In the driver list box of the Create New Data Source dialog box, select the Merant OEM 5.0 TextFile driver,
and click Finish.

The General tab of the ODBC Text Driver Setup dialog box for flat file configuration is displayed.

3 In the Data Source Name text box, type a name for the flat file data source.

4 Optional: If you want to record a description, in the Description text box, type a description that indicates
how you use this data source name.

For example, you might type the following to describe the My Business database:

Customers, products, markets

5 In the Database Directory text box, type the path to the folder where the flat files are located.

6 In the Default Table Type drop-down list, select whether the text file is comma-separated, tab-separated,
character-separated, fixed length, or stream.

Note:

If your text files are character-separated, type the character that is used as a delimiter in the
Delimiter Character text box.

7 If the first line of your text files contains the column names of the database table, select the Column Names
in First Line check box; otherwise, proceed to Step 8.

8 Select the Advanced tab.

9 In the Rows to Scan text box, type the number of rows that should be scanned for the driver to determine
the data types in the file.

The default is 25 rows. If 0 is entered, all rows in the file are scanned.

10 In the Action for Undefined Tables group, choose one of the following actions that the driver should take
when it encounters a file that has not been defined.

● Prompt for Definition. The text driver prompts you when it encounters a file that has not
been defined.

● Guess Definition. The text driver analyzes the file and guesses the file’s format.

Note:

The options in the Return Additional Tables group are not supported.

11 Complete the following steps to define the structure of your data source text files:

a. Click the Define button to display the Define File dialog box.

b. Navigate to the folder that contains your data source text files.

c. Select a text file to define and click Open to display the Define Table dialog box.

d. In the Table text box, type a table name to associate with this text file.

The table name you define is the table name that will be displayed in the left frame of the
OLAP Model main window.

e. If the first line of text in the file contains the column names, select the Column Names in
the First Line check box.
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If the first line of the text file does not contain the column names, then do not select this
check box.

f. From the Table Type drop-down list, select the delimiter that is used in the text file.

g. If you select Character in the Table Type drop-down list in Step f, specify the character in
the Delimiter Character text box.

You can specify any printable character except single and double quotation marks.

h. In the Decimal Symbol text box, specify either a comma or period as a decimal separator
to use when data is stored.

12 Perform one of the following actions to define the column names:

● If you specified in Step 11f that your text files were comma-separated, tab-separated, or
character-separated, click the Guess button to have the text driver guess at the column names
and display them in the list box under Column Information.

● If you specified in Step 11f that your text files were fixed-length or stream type, click the
Parse button to display the Parse Table dialog box, where you define the table column names.

For more information on using the Parse Table dialog box, see the DataDirect Connect ODBC
Reference. You can also view the DataDirect online help by clicking the Help button in the
Parse Table dialog box.

● If you want to define the values and fields for each column manually, click Add to add the
column name to the list box under Column Information.

For each table that you add manually, you must specify the data type, data mask (where
appropriate), column precision, column scale, length, and offset. For more information on
these settings, see the DataDirect Connect ODBC Reference. You can also view the DataDirect
online help by clicking the Help button in the Define Table dialog box.

13 Optional: Modify or delete any of the existing column definitions by selecting a column name in the list box
under Column Definition and clicking the Modify or Remove button.

14 Click OK to define the table.

15 Complete Step 11 through Step 14 for each data source table that you want to define.

16 When you have finished defining each data source table, click Cancel in the Define File dialog box to return
to the Advanced tab of the ODBC Text Driver Setup dialog box.

17 Specify the remaining settings on the Advanced tab.

For information on the remaining settings, refer to the DataDirect Connect ODBC Reference in
the PDF file in $HYPERION_HOME/common/ODBC/Merant/5.0/docs . You can also view the
DataDirect online help by clicking the Help button in the Advanced tab of the ODBC Text Driver
Setup dialog box. 
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Configuring the SQL Server ODBC Driver for Microsoft SQL
Server
Use the following procedure to configure a data source name for your Data Source database
using the SQL Server driver. Then repeat the procedure to configure a data source name for your
OLAP Metadata Catalog database.

Note:

You may repeat the configuration procedure to create any number of data source names to
relational Data Source databases or OLAP Metadata Catalog databases.

The procedures that follow provide information on basic configuration. If you are using more
advanced options, refer to the online help for each wizard screen for assistance in completing
the wizards.

➤ To use the SQL Server driver to configure a data source name:

1 Access ODBC Data Source Administrator by following the procedure in “Accessing ODBC Data Source
Administrator” on page 36.

2 Click Add to open the Create New Data Source dialog box.

3 In the driver list box of the Create New Data Source dialog box, select the SQL Server driver, and click
Finish.

The Create a New Data Source to SQL Server dialog box is displayed.

4 In the Name text box, type the data source name that you want to use for this data source connection.

In the sample application, TBC is the data source name used to connect to the Data Source
database called TBC; TBC_MD is the data source name used to connect to the sample OLAP
Metadata Catalog database called TBC_MD.

5 Optional: In the Description text box, type a description that indicates how you use this data source name.

For example, you might type the following names to describe the My Business database:

Customers, products, markets

You might type the following statement to describe the sample application database:

Sample relational data source

You might type the following statement to describe the sample OLAP Metadata Catalog database:

Sample OLAP Metadata Catalog

6 In the Server text box, type the address (either the computer name or the numeric IP address) of the computer
where the database tables are stored.

7 Click Next.

The second wizard screen is displayed.

8 Select the appropriate option button for the method to use for verifying login IDs:

44 Configuring Data Sources



● With Window NT authentication using the network login ID.

● With SQL Server authentication using a login ID and password entered by the user.

9 Optional: If you are using a network library other than TCP/IP (the default) to connect to the database server,
perform the following steps:

a. Click the Client Configuration button.

b. In the Network libraries list, select the appropriate option button for the library that you
are using to connect to the database server computer, and click OK.

You are returned to the second wizard screen.

10 Optional: Select the Connect to SQL Server to obtain default settings for the additional
configuration check box.

When this check box is selected, the driver obtains default settings from SQL Server that it uses
to complete additional setup screens in the wizard.

When this check box is clear, the driver uses standard defaults to complete the additional setup
screens in the wizard.

11 Click Next.

The third wizard screen is displayed.

12 Select the Change the default database to check box and then type or select the name of the database
for which you want to create this data source name.

For example, in the sample application, TBC is the name of the Data Source database; TBC_MD
is the name of the OLAP Metadata Catalog database.

13 Click Next.

The fourth wizard screen is displayed.

14 Make any entries appropriate to your system configuration and click Finish.

15 Repeat Step 2 through Step 14 to configure a data source name for an OLAP Metadata Catalog.

16 When you have completed configuring all needed data sources, click OK to close the ODBC Data Source
Administrator dialog box.

Configuring the Teradata ODBC Driver for Teradata
Use the following procedure to configure a data source name for your Data Source database
using the Teradata driver. Then repeat the procedure to configure a data source name for the
relational database that you want to use as your OLAP Metadata Catalog database.

Note:

You may repeat the configuration procedure to create any number of data source names to Data
Source databases or OLAP Metadata Catalog databases.
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➤ To configure a data source name:

1 Access the ODBC Data Source Administrator by following the procedure in “Accessing ODBC Data Source
Administrator” on page 36.

2 Click Add to open the Create New Data Source dialog box.

3 In the driver list box of the Create New Data Source dialog box, select Teradata, and click Finish.

The ODBC Driver Setup for Teradata RDBMS dialog box is displayed.

4 In the Name text box, type the data source name that you want to use for this data source connection.

In the sample application, TBC is the data source name used to connect to the Data Source
database called TBC; TBC_MD is the data source name used to connect to the sample OLAP
Metadata Catalog database called TBC_MD.

5 Optional: In the Description text box, type an description that indicates how you use this data source name.

For example, you might type the following to describe the My Business database:

Customers, products, markets

You might type the following to describe the sample application database:

Sample relational data source

You might type the following to describe the sample OLAP Metadata Catalog database:

Sample OLAP Metadata Catalog

6 In the Teradata Server Info text box, type the address (either the computer name or the numeric IP address)
of the computer where the database tables are stored.

7 In the Default Database text box, type the name of the database for which you want to create this data
source name.

For example, in the sample application, TBC is the name of the Data Source database; TBC_MD
is the name of the OLAP Metadata Catalog database.

8 Optional: Enable the X Views option for Teradata.

You can limit the number of data sources displayed in the left frame of an OLAP Model main
window based on the security of the Teradata user ID that was used to connect. Follow steps a
through c to enable the X Views option:

a. Click the Options button.

b. Check the Use X Views check box.

c. Click OK to return to the ODBC Driver Setup for Teradata RDBMS dialog box.

9 Click OK to return to the System DSN tab of the ODBC Data Source Administrator dialog box.

The data source name that you entered and the driver that you mapped to it are displayed in the
System Data Sources list box.

10 Repeat Step 2 through Step 9 above to configure a data source name for an OLAP Metadata Catalog.
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Note:

You may repeat the above procedure to create any number of data source connections to
relational data sources or OLAP Metadata Catalogs.

11 When you have completed configuring all needed data sources, click OK to close the ODBC Data Source
Administrator dialog box.

Editing a Data Source Name

➤ To edit configuration information for a data source name:

1 Access the ODBC Data Source Administrator by following the procedures in “Accessing ODBC Data Source
Administrator” on page 36.

2 Select the data source name and click Configure to open the driver setup dialog box or wizard specific to
your RDBMS.

3 Correct any information that you want to change.

Using Oracle OCI Direct Connection for Oracle
If you are using Oracle OCI, Integration Services requires that the Oracle client software must
be 32-bit. Oracle 32-bit client software and Integration Server must be installed on the same
computer. When using OCI direct connection, the database client software is required to make
connections to RDBMS databases. For information about installing and configuring database
client software, refer to the Oracle RDBMS installation documentation.

On Windows systems, environment changes needed for running the database client software
should be completed automatically by the Oracle 32-bit client installation program. For
information about additional configuration of the database client software, see the Oracle
documentation.

To test OCI connections, ensure that you can connect to RDBMS databases and access tables
while logged on with the user account that you use to run Integration Server. Use the SQL
command line utility provided with the Oracle 32-bit database client software that you are using.

With Oracle OCI, you connect to the OLAP Metadata Catalog database and Data Source database
at login time in Integration Services Console. You make the connection by typing Oracle:
before the data source name for the OLAP Metadata Catalog database and the data source name
for the relational database. This process is described in “Connecting to Integration Server” on
page 54 and “Connecting to Data Sources” on page 57.

After Configuration of Data Source Names
After you configure data source names for the Data Source database and OLAP Metadata Catalog
database, you can connect to databases from Integration Services. You can then create, modify,
and save OLAP models and metaoutlines. For information on viewing TBC tables, columns,
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OLAP models, and metaoutlines in Integration Services Console, see “Viewing TBC Tables and
Columns ” on page 96.

If you plan to use flat (text) files as data source, you must set up data source names for those
files. “Configuring Data Source Names on Windows Systems” on page 35.

Note:

The SQL Server ODBC driver may time out during a call to an SQL Server database, particularly
during a data load. If a timeout occurs, try again when the database is not busy. Increasing the
driver time-out period may avoid this problem. For more information, see the ODBC
documentation for the driver that you are using.

For more information on ODBC connection problems and solutions, see the Essbase Integration
Services System Administrator's Guide.
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Post-Installation Tasks
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This chapter describes the post-installation procedures necessary to use Integration Services
software. Included are instructions for starting and stopping Integration Services, starting
Integration Services Console, and connecting to server components and data sources.

Tip:

During installation, configuration, and testing, keep a list of all user names and passwords that
you use to create or modify the system, including the applications with which they are associated
and their purpose.

Starting and Stopping Integration Server on Windows Systems
After you install the server software on Windows systems, you can choose any of the following
options for Integration Server operation:

● “Starting and Stopping Integration Server from Windows Desktop” on page 50

● “Starting and Stopping Integration Server from the DOS Command Line” on page 50

● “Enabling, Starting, and Stopping Integration Server as a Windows Service” on page 50

● “Removing or Reinstalling the Windows Service” on page 114

Note:

Before starting Integration Server as a Windows service, you must first enable the Windows
service. See “Enabling Integration Server as a Windows Service” on page 51 for instructions
on enabling the Windows service.
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Starting and Stopping Integration Server from Windows
Desktop

➤ To start Integration Server from the Windows desktop Start menu:

1 On the Windows desktop, click Start.

2 Select Programs > Hyperion > Integration Services > Integration Server..

➤ To stop Integration Server from the Windows desktop:

1 In the Windows task bar, right-click the button representing Integration Server.

2 From the pop-up menu, select Close.

Starting and Stopping Integration Server from the DOS
Command Line

➤ To start Integration Server from the command line, start a DOS window and type ais_start
at the command prompt.

When you first start Integration Server, it creates the Integration Server log, olapisvr.log, in
the log directory. To write to a log in another directory, add an entry to the startup.bat file
or the ais.cfg file specifying the directory. The syntax for the ais.cfg file:

[-E]=directory_name\log_name 

Note:

Do not type the .log file extension. The .log extension is automatically appended to the name
that you type for the log.

➤ To stop Integration Server from the command line, start a DOS window and type ais_stop at
the command prompt.

For more information on starting and stopping Integration Server from the command line using
the startup.bat command, and on using the startup.bat file or ais.cfg file to store
startup parameters, see the Essbase Integration Services System Administrator's Guide.

Enabling, Starting, and Stopping Integration Server as a
Windows Service
The Integration Services installation program automatically installs the Windows service for
Integration Server in “Disabled” mode. Before you can start the server as a Windows service,
you must first enable the service.
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Enabling Integration Server as a Windows Service
You need to complete the procedure in this topic only once to enable automatic startup of the
Windows service for Integration Server.

➤ To enable the Windows service for the first time on Windows 2000:

1 Select Start > Settings > Control Panel.

2 Double-click Administrative Tools, and then double-click Services.

The Services dialog box is displayed with Essbase Integration Server in the list of services.

3 In the list of services, double-click Essbase Integration Server.

4 Enable the Windows service. Select Action > Properties to open the Properties dialog box, select
Automatic from the Startup type pull-down list, click Start to start the service, and click OK.

You can also select the Manual startup type if you want to start the Windows service manually.
If you choose Manual, see “Starting and Stopping Integration Server as a Windows Service” on
page 51 for instructions on starting the service.

➤ To enable the Windows service for the first time on Windows XP:

1 Select Start > Control Panel.

2 In the Control Panel, select the Performance & Maintenance link and then the Administrative Tools link.

3 In the Administrative Tools window, double-click Services.

The Services dialog box is displayed with Essbase Integration Server in the list of services.

4 In the list of services, double-click Essbase Integration Server.

5 In the Startup type drop-down list, select Automatic and click Apply.

You can also select the Manual startup type if you want to start the Windows service manually.
If you choose Manual, see “Starting and Stopping Integration Server as a Windows Service” on
page 51 for instructions on starting the service.

Starting and Stopping Integration Server as a Windows Service
After you enable the Windows service the first time and select the automatic startup option, the
Windows service for Integration Server is started automatically when you log on Windows. You
may need to start the service manually at a later time—for example, you may want to stop the
service to adjust the startup settings and restart the service. This topic describes starting and
stopping the service.

Note:

You can start the Windows service for Essbase Integration Server by using the same switches
that you use when starting Integration Server from the DOS command line. For information on
the switches and on using the ais.cfg or startup.bat file to store startup switches, see the
Essbase Integration Services System Administrator's Guide.
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➤ To start Integration Server as a Windows service:

1 Access the Services dialog box.

● On Windows 2000, select Start > Settings > Control Panel, double-click Administrative
Tools, and then double-click Services.

● On Windows XP, select Start > Control Panel. In the Control Panel, select Performance &
Maintenance and then Administrative Tools. In the Administrative Tools window, double-
click Services.

● On Windows 2003, select Start > Control Panel. In the Control Panel, select Administrative
Tools. In the Administrative Tools window, double-click Services.

The Services dialog box is displayed with Essbase Integration Server in the list of services.

2 Select, but do not double-click, Essbase Integration Services.

Note:

For information on using startup switches when starting Integration Server as a Windows service,
see the Essbase Integration Services System Administrator's Guide.

3 Start the service for Essbase Integration Server.

● On Windows 2000, select Action > Start.

● On Windows XP and Windows 2003, right-click Essbase Integration Server and select Start.

On Windows 2000, the Service Control message box is displayed. After a short delay, the
message box disappears, the Status field entry for Essbase Integration Server is changed, and
the server is started.

On Windows XP and Windows 2003, the Service Control message box is briefly displayed.
The Status field entry for Essbase Integration Server is changed, and the server is started.

➤ To stop Essbase Integration Server as a Windows service:

1 Access the Services dialog box.

● On Windows 2000, select Start > Settings > Control Panel, double-click Administrative
Tools, and then double-click Services.

● On Windows XP and Windows 2003, select Start > Control Panel. In the Control Panel,
select Performance & Maintenance, and then Administrative Tools. In the Administrative
Tools window, double-click Services.

● On Windows 2003, select Start > Control Panel. In the Control Panel, select Administrative
Tools. In the Administrative Tools window, double-click Services.

The Services dialog box is displayed with Essbase Integration Server in the list of services.

2 Select, but do not double-click, Essbase Integration Server.

3 Stop the service.

● On Windows 2000, select Action > Stop.
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● On Windows XP and Windows 2003, right-click Essbase Integration Server and select
Stop.

On Windows 2000, the Service Control message box is displayed. After a brief delay, the
message box disappears, the Status field for Essbase Integration Server is changed, and the
server is stopped.

On Windows XP and Windows 2003, the Service Control message box is briefly displayed.
The Status field entry for Essbase Integration Server is changed, and the server is stopped.

Starting Integration Services Console
After you install the client software, complete the following procedure to start Integration
Services Console.

➤ To start Integration Services Console:

1 On the Windows desktop, click Start.

2 Select Programs > Essbase > Integration Services > Integration Services Console.

Note:

To display the Integration Services Console in a language other than English, follow the
procedure in “Enabling Regional Options for Multiple Languages” on page 103.

Connecting to Server Components and Data Sources
Whether you are installing Integration Services for the first time or upgrading from a previous
release, after you start the console, the OLAP Metadata Catalog Setup dialog box is displayed.
Using this dialog box, you can either create a catalog or upgrade an existing catalog.

Note:

An OLAP Metadata Catalog must be created and configured before you can connect to it. For
information on configuring a relational data source for an OLAP Metadata Catalog, see
Chapter 5, “Configuring Data Sources.” For information on creating OLAP Metadata Catalogs,
see Chapter 7, “Creating, Upgrading, and Deleting OLAP Metadata Catalogs.”

After the process of creating or upgrading an OLAP Metadata Catalog is complete, you can begin
to create OLAP models and metaoutlines. You must connect to Integration Server, to an external
data source, and to the OLAP Metadata Catalog where you want to store the OLAP models and
metaoutlines that you create.

To use Integration Services Console to perform data loads, member loads, or member and data
loads, you must connect the client software to an additional server component, Essbase Server.
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You are prompted by the Login dialog box to connect to an Integration Server and an OLAP
Metadata Catalog. Optionally, in the Login dialog box, you can also connect to an instance of
Essbase Server and create default connection settings for both server components.

The following topics present various connection–related procedures:

● “Connecting to Integration Server” on page 54

● “Connecting to Essbase Server” on page 55

● “Setting Connection Defaults” on page 56

● “Connecting to Data Sources” on page 57

● “Reconnecting When Connections Are Lost” on page 60

For information on troubleshooting connections to server components, see the Essbase
Integration Services System Administrator's Guide.

Connecting to Integration Server
Integration Server manages access to OLAP Metadata Catalogs and to data sources. A catalog
stores information that defines the external data source and the structure of OLAP model and
metaoutline elements. To create an OLAP model or a metaoutline, you must connect to
Integration Server.

Note:

The Integration Server system administrator must provide a user name and password to an
OLAP Metadata Catalog before you can connect to the server.

Note:

It is highly recommended that you do not connect the Integration Server and Integration Services
Console via a wide area network (WAN). Doing so may cause severe performance degradation.

➤ To connect to Integration Server:

1 To display the Login dialog box from the OLAP Model main window or the Integration Services Console,
select Connections > OLAP Metadata Catalog>Connect.

Note:

The Login dialog box is displayed automatically when you start Integration Services Console.
You can redisplay the Login dialog box by using the procedures described in this topic.

2 In the Server drop-down list under Integration Services, type or select the name of an Integration Server
computer; for example, cypress.

If the port number on which Essbase Integration Server communicates with the console has
been set to a value other than the default, you must type the server name or IP address and type
the nonstandard port number, separated by a colon; for example:
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cypress:3390

3 In the OLAP Metadata Catalog drop-down list, select the name of an OLAP Metadata Catalog; for example,
TBC_MD for the sample TBC (The Beverage Company) database.

Oracle OCI: If you are using Oracle Call Interface (OCI) direct connection, you must specify
the data source name in the format, Oracle:sid; for example:

Oracle:TBC

4 In the Code Page drop-down list box, select the code page of the language you want to use during the current
Integration Services Console session.

The code page is a portion of the locale which identifies the local language and cultural
conventions such as the formatting of currency and dates and the sort order of data.

5 In the User Name drop-down list box under Integration Services, type or select your user name.

It is necessary to type a user name the first time it is used. After a user is successfully connected
to Integration Services, the user name is then displayed in the User Name drop-down list.

6 In the Password text box under Essbase Integration Server, type your password.

Note:

Use the same user name and password that you use to connect directly to the database server
and to access the database that contains the OLAP Metadata Catalog.

7 Click OK or enter information for connecting to an instance of Essbase Server (see “Connecting to Essbase
Server” on page 55).

Connecting to Essbase Server
Essbase Server creates and manages Essbase databases. You do not have to connect Integration
Services Console to Essbase Server to create an OLAP model or metaoutline, but you must
connect to Essbase Server to view a sample Essbase outline or to load members or data into an
Essbase database.

In the Login dialog box, you can specify the information for connecting to Essbase Server, but
Integration Services Console does not connect to Essbase Server until you attempt to view a
sample Essbase outline or to load members or data.

If you plan to use Essbase Integration Services Console on a client computer that is outside the
firewall for your network, and the console requires that Integration Server and Essbase Server
be located inside the firewall for your network, you must log on to Essbase Server with a name
or an IP address that connects from both sides of the firewall. The system administrator provides
you with this name or IP address.

Note:

The system administrator for Essbase Server must provide you with a user name and password
before you can connect.
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➤ To set connection information for an instance of Essbase Server:

1 In the OLAP Metaoutline main window, select Connections>OLAP Metadata Catalog>Connect to display
the Login dialog box.

Note:

The Login dialog box is displayed automatically when you start Integration Services Console.
You can redisplay the Login dialog box at any time while working in the OLAP Metaoutline
main window by using the procedures described in this topic.

2 In the Server text box under Essbase Server, type or select the name of a computer that is running Essbase
Server; for example, sequoia.

Note:

If you are using Integration Services Console on a client computer that is outside the firewall for
your network, and you require access to instances of Integration Server and Essbase Server
located inside the firewall for your network, be sure to use a name or an IP address for the instance
of Essbase Server that is accessible from both sides of the firewall.

3 In the User Name drop-down list box under Essbase Server, type or select your Essbase user name.

It is necessary to type a user name the first time it is used. After a user is successfully connected
to Essbase Server, the user name is then displayed in the User Name drop-down list.

4 In the Password text box under Essbase Server, type your Essbase password.

5 Click OK.

Setting Connection Defaults
If you typically use a specific instance of Integration Server, OLAP Metadata Catalog, and Essbase
Server, you can save the settings as the default. After you set default connection information,
you can reuse these settings without reentering the information.

If you use multiple instances of Integration Server and OLAP Metadata Catalogs, you can also
set multiple relationships and select the appropriate one to use so that you do not need to reenter
the information.

➤ To set connection defaults:

1 To display the Login dialog box, in the OLAP Model main window or OLAP Metaoutline main window, select
Connections>OLAP Metadata Catalog>Connect.

2 In the Login dialog box, click Set Login Defaults.

The Set Login Defaults dialog box is displayed.

3 In the Server text box, type or select the name of an Integration Server computer; for example, cypress.

4 In the OLAP Metadata Catalog text box, type or select the name of an OLAP Metadata Catalog; for example,
TBC_MD for the sample TBC database.
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5 In the Code Page drop-down list box, select the code page of the language you want to use for this Integration
Services Console session.

The code page is a portion of the locale which identifies the local language and cultural
conventions such as the formatting of currency and dates and the sort order of data.

6 In the User Name text box, type or select a user name for the OLAP Metadata Catalog.

7 Take one of the following actions:

● To set the connection defaults, click Set Default.

● To save the connection information without setting the information as the default, click
Add to List.

8 In the Default Server text box, type or select the name of an Essbase Server computer; for example, cypress.

9 In the Default User Name text box, type or select a user name for the instance of Essbase Server; for example,
TBC.

10 Click OK to return to the Login dialog box.

Connecting to Data Sources
A data source is an external data repository—typically a large database—whose data you want
to analyze by using Essbase. You must connect Integration Services to all data sources that you
plan to use in creating OLAP models and metaoutlines and in loading data into an Essbase
database.

Note:

You can connect to more than one relational data source to create OLAP models.

➤ To connect to a data source:

1 In the Integration Services Console Welcome dialog box, click the appropriate icon to create a new OLAP
model or metaoutline. Alternatively, select the Existing or Recent tab and double-click an OLAP model or
metaoutline to open it for editing.

The Data Source dialog box is displayed.

2 In the Data Source drop-down list, select the data source to be used; for example, TBC in the sample
application.

An ODBC data source must be created on the computer that is running Integration Server for
any external data sources that you want to use. With the exception of Oracle Call Interface (OCI)
direct connection, if the data source that you need is not visible in the scroll list, contact the
Integration Services system administrator.

For more information about troubleshooting server and data source connections, see the Essbase
Integration Services System Administrator's Guide.

Oracle OCI: If you are using Oracle OCI direct connection, be sure to prefix the Net Service
Name (found in the tnsnames.ora file) or the Schema Name (if you are using onames) with
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“Oracle” by typing Oracle: and then the Net Service Name or Schema Name, as shown in
Figure 3.

Figure 3 Entering a Data Source Name When Using OCI Direct Connection

The following example is a Net Service Name stanza that defines TBC in the tnsnames.ora file:

TBC =
  (DESCRIPTION =
    (ADDRESS_LIST =
      (ADDRESS = (PROTOCOL = TCP)(HOST = labmachine2)(PORT = 1521))
    )
    (CONNECT_DATA =
      (SERVICE_NAME = orasid)
    )
  )

For Oracle using onames, in the example above, TBC is the Schema Name used to connect to
an Oracle database. This is the database identifier that you use when you are using SQL *Plus to
connect to a database.

DataDirect Drivers: If you are using DataDirect drivers with Oracle, pick a data source name
from the Data Source drop-down list.

3 In the Code Page drop-down list box, select the code page of the language you want to use during the
current Integration Services Console session, and click OK.

The code page is a portion of the locale which identifies the local language and cultural
conventions such as the formatting of currency and dates and the sort order of data.

4 In the User Name drop-down list box, type or select your user name.

Note:

If you are using a flat file data source, no user name is required.

5 In the Password text box, type your password.

Note:

If you are using a flat file data source, no password is required.

6 Click OK

The left frame of the OLAP Model main window initially displays information about the first
data source to which you connected. Data source information is displayed hierarchically by data
source name and owner name.

For each owner name, data is further sorted and organized by tables, views, and synonyms. You
can use the listed source tables to create an OLAP model or use additional source tables by
connecting to other data sources.
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Information about subsequent data sources to which you connect is displayed in the same
manner as information about the first connected data source was displayed; that is, by data
source name and owner name, then tables, views, and synonyms.

Expand the plus sign, , to display tables, views, and synonyms contained in the data source.

If you want to connect to additional data sources, complete the steps in the following procedure:

➤ To connect to additional data sources:

1 Select Connections > Add Data Sources.

The Data Source dialog box is displayed. You can connect to any number of available data sources
without closing this dialog box.

2 In the Data Source drop-down list, select the additional data source to which you want to connect.

Oracle: If you are using OCI direct connection, be sure to prefix the Net Service Name or the
Schema Name with “Oracle” by typing Oracle: and then the data source name, as shown in
Figure 3.

If you are using DataDirect drivers with Oracle, pick a data source name from the Data Source
drop-down list.

3 In the Code Page drop-down list box, select the code page of the language you want to use during the
current Integration Services Console session, and click OK.

4 In the User Name drop-down list box, type or select your user name.

It is necessary to type a user name the first time it is used. After a user is successfully connected
to a data source, the user name is then displayed in the User Name drop-down list.

Note:

If you are using a flat file data source, no user name is required.

5 In the Password text box, type your password and click Connect.

Note:

If you are using a flat file data source, no password is required.

The left frame of the OLAP Model main window displays information about the data source to
which you just connected along with information about the first data source to which you
connected.

6 Repeat Step 2 through Step 3 for each data source to which you want to connect.

As you connect to additional data sources, the left frame of the OLAP Model main window
displays information about all data sources to which you are connected.

7 When you finish connecting to all appropriate data sources, click Close.
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Reconnecting When Connections Are Lost
If a connection is lost to Integration Server and OLAP Metadata Catalog, you can reconnect
without losing any unsaved work on the OLAP models or metaoutlines.

➤ To reconnect to Integration Server and OLAP Metadata Catalog:

1 Start Integration Server.

2 In the Integration Services Console, select Connections>OLAP Metadata Catalog>Reconnect.

Note:

The connection is made automatically; no messages are displayed, and you do not need to reenter
information in the Login dialog box.

Completing Post-Installation Tasks
To complete the installation of Integration Services, see Chapter 5, “Configuring Data
Sources,” and Chapter 7, “Creating, Upgrading, and Deleting OLAP Metadata Catalogs.” To
work with the sample application, see Chapter 8, “Setting Up the Sample Applications.”

For detailed information about installed files, directories, environment changes made by the
installation program, and uninstalling the software, see Chapter 9, “Completing Advanced
Installation Tasks,” and Chapter 10, “Uninstalling Integration Services.”

Tip:

During installation, configuration, and testing, keep a list of all user names and passwords that
you use to create or modify the system, including the applications with which they are associated
and their purpose.
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Catalogs
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Before you run Integration Services, you must create an OLAP Metadata Catalog to store the
OLAP models that you create and the metaoutlines that you build from the OLAP models.

Note:

If you intend to use the Sample application to acquaint yourself with Integration Services, skip
to Chapter 8, “Setting Up the Sample Applications.” The Sample application has its own
relational data source, OLAP Metadata Catalog, OLAP model, and metaoutline. Return to this
chapter when you are ready to use a relational data source to build OLAP models and
metaoutlines. It is recommended that you use the automatic installation process to install the
Sample applications. See “Setting Up the Standard Sample Application Automatically” on page
73.

This chapter tells you what to consider before you create an OLAP Metadata Catalog in a
relational database. You can create the catalog either automatically, through the use of
Integration Services Console, or manually. You can also manually create a Unicode-enabled
OLAP Metadata Catalog. For manual creation of an OLAP Metadata Catalog, this chapter lists
the SQL scripts that you must run to create tables for the catalog. The procedures in this chapter
assume that you know how to create tables by running SQL scripts.

About OLAP Metadata Catalogs
An OLAP Metadata Catalog is a database that consists of 33 tables in which Integration Services
stores OLAP models and metaoutlines.

For a complete list of supported RDBMSs, see Essbase Integration Services ODBC Support
Matrix.
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You can run the RDBMS for an OLAP Metadata Catalog on any platform as long as you have
the ODBC driver and database client software required to connect to the catalog from the
computer that runs Essbase Integration Server. You can also run the RDBMS for the relational
data source that you use to create OLAP models and build metaoutlines on any platform, if you
have the ODBC driver and database client software required to access the data source. For a
detailed matrix of specifically supported databases and ODBC drivers, see Essbase Integration
Services ODBC Support Matrix.

The RDBMS for the OLAP Metadata Catalog can be different from the RDBMS for the relational
data source, and the platforms for the two RDBMSs do not need to be the same.

You can have more than one OLAP Metadata Catalog and, by using the XML Import/Export
utility, you can move OLAP models and metaoutlines from one OLAP Metadata Catalog to
another OLAP Metadata Catalog.

Creating or Upgrading OLAP Metadata Catalogs
To create an OLAP Metadata Catalog, you must have permission to create tables in the database
or have whatever similar access privileges are required by the RDBMS that you are using. 

Note:

MS SQL Server—The tables in a catalog are not accessible if they are created by a user that does
not have db_owner privileges.

➤ To create an OLAP Metadata Catalog:

1 Perform the steps in “Preparing to Install Integration Services” on page 17.

2 Create a database for OLAP Metadata Catalog tables using the applicable RDBMS utility.

See “Creating Databases for OLAP Metadata Catalog Tables” on page 62.

3 Take one of the following actions:

● Create an OLAP Metadata Catalog automatically by using Integration Services Console (see
“Creating or Upgrading OLAP Metadata Catalogs Automatically” on page 63).

● Create tables for the OLAP Metadata Catalog database by running SQL scripts (see “Creating
OLAP Metadata Catalogs Manually” on page 64).

Creating Databases for OLAP Metadata Catalog Tables
Create a database for the OLAP Metadata Catalog tables by using the applicable RDBMS utility,
in the same way that you create any database.

● Create a database device or tablespace

● Allot 30 MB for storage

● Create user names and passwords, if needed
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● Grant user privileges or permissions

One OLAP Metadata Catalog can store all OLAP models and metaoutlines from numerous
relational data sources. You can also create separate OLAP Metadata Catalogs to store additional
OLAP models and metaoutlines for different projects.

Creating or Upgrading OLAP Metadata Catalogs
Automatically
When you complete installation of Integration Services and start Integration Services Console,
the program automatically displays the OLAP Metadata Catalog Setup dialog box, as shown in
Figure 4.

This dialog box enables you to create a standard OLAP Metadata Catalog automatically, using
Integration Services Console. If you have an older version of the OLAP Metadata Catalog, you
also use this dialog box to upgrade the older version to the current version.

Figure 4 OLAP Metadata Catalog Setup Dialog Box

If you prefer to create the OLAP Metadata Catalog manually, see “Upgrading OLAP Metadata
Catalogs Manually” on page 65.

➤ To create an OLAP Metadata Catalog automatically:

1 From the Server Name drop-down list in the OLAP Metadata Catalog Setup dialog box, type or select the
server computer on which you have installed Essbase Integration Server.

It is necessary to type a server name the first time it is used. After the OLAP Metadata Catalog
is successfully created, the server name is then displayed in the Server Name drop-down list box.
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2 From the Catalog ODBC DSN drop-down list, select the Data Source Name for the OLAP Metadata Catalog
that you are creating.

Oracle: If you are using OCI direct connection, be sure to prefix the Net Service Name or the
Schema Name with “Oracle” by typing Oracle: and then the data source name.

Note:

You must create the database in which you will store the OLAP Metadata Catalog, assign the
appropriate user permissions, and configure the ODBC connection before you can create the
catalog.

3 In the Code Page drop-down list box, select the code page that corresponds to the code page of the relational
database that will be used as the OLAP Metadata Catalog.

The code page is a portion of the locale which identifies the local language and cultural
conventions such as the formatting of currency and dates and the sort order of data.

4 In the User Name drop-down list, select or type the user name to which you have assigned permission to
access the database in which the OLAP Metadata Catalog will be stored.

5 In the Password text box, type the password for the user name to which you have assigned permission to
access the database in which the OLAP Metadata Catalog will be stored.

6 If you want the OLAP Metadata Catalog Setup dialog box to be displayed automatically each time you start
Integration Services Console, leave the Show this dialog at Startup check box selected.

If you do not select the Show this dialog at Startup check box, you can access the OLAP Metadata
Catalog Setup dialog box from the console by selecting Tools > Create Catalog.

If an OLAP model or metaoutline is open when you select Tools > Create Catalog, you are
prompted to disconnect from the current catalog (Connections > OLAP Metadata Catalog >
Disconnect). Note that disconnecting from an OLAP Metadata Catalog causes the open OLAP
model or metaoutline to close.

7 Click Create.

Integration Services Console creates the OLAP Metadata Catalog automatically.

Note:

If you are migrating from a previous release of Integration Services, the OLAP Metadata Catalog
auto-creation process upgrades the existing OLAP Metadata Catalog.

Creating OLAP Metadata Catalogs Manually
If you choose to create the OLAP Metadata Catalog manually, you must run SQL scripts by using
the same utility program that you normally use to create tables.

The scripts that you use to create the tables for a non-Unicode OLAP Metadata Catalog are
named:

 oc_create_database_name.sql 

The scripts that you use to create the tables for a Unicode OLAP Metadata Catalog are named:
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 oc_create_database_name_unicode.sql 

These scripts are listed in Table 3 on page 67, along with the utility programs with which they
have been tested.

Note:

Hyperion strongly recommends that you use the automatic installation process to create the
OLAP Metadata Catalog (see “Creating or Upgrading OLAP Metadata Catalogs Automatically”
on page 63).

➤ To create tables for the OLAP Metadata Catalog database manually:

1 Start the utility program.

2 Connect to the database that you created for the OLAP Metadata Catalog.

3 Open the appropriate SQL script file in the ocscript directory.

4 Run the SQL script to build the tables.

On SQL Server, you receive a message that you did not create data or rows. This message is
normal because you created only tables and columns.

5 Verify that you have created the OLAP Metadata Catalog tables.

For example, type a command such as:

SELECT * FROM JOIN_HINTS 

or, start the applicable RDBMS utility program and verify that the OLAP Metadata Catalog has
the new tables.

6 Close the utility program.

Upgrading OLAP Metadata Catalogs Manually
If you have OLAP Metadata Catalogs from an earlier release of Integration Services and you
choose not to use the automatic creation-upgrade process, you must upgrade the existing OLAP
Metadata Catalogs manually. You cannot use the existing catalogs with the new release of
Integration Services until the catalogs are upgraded.

Note:

If you use Integration Services Console to create an OLAP Metadata Catalog automatically, the
system upgrades existing OLAP Metadata Catalogs and you do not need to upgrade them
manually (see “Creating or Upgrading OLAP Metadata Catalogs Automatically” on page 63).
Hyperion recommends that you use the automatic process to create the OLAP Metadata Catalog.

You manually upgrade the tables of an OLAP Metadata Catalog by running the SQL scripts that
use the same database utility program that you typically use to create tables. The SQL scripts to
upgrade tables for the OLAP Metadata Catalog are in the ocscript directory where you installed
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Integration Services. The upgrade scripts are named oc_upgrade*_ database_name.sql and
are listed in Table 3 on page 67, along with the utility programs with which they have been
tested.

Note:

If you manually rebuild an OLAP Metadata Catalog, you must drop (delete) the catalog tables
by using oc_drop*database_name.sql. Then you create the OLAP Metadata Catalog tables
by using oc_create*database_name.sql. If you choose to rebuild a catalog manually, it is
not necessary to run any upgrade scripts.

Caution!

If you drop (delete) an OLAP Metadata Catalog, you also delete the OLAP models and
metaoutlines that it contains.

The following topics discuss various aspects of upgrading OLAP Metadata Catalogs manually:

● “SQL Scripts Used to Create and Upgrade Tables” on page 66

● “Proper Order of SQL Scripts” on page 68

● “Upgrading Tables in the OLAP Metadata Catalog” on page 69

SQL Scripts Used to Create and Upgrade Tables
The SQL scripts to create tables for the OLAP Metadata Catalog (listed in Table 3) are located
in the ocscript directory where you installed Integration Services.

Integration Services provides SQL scripts for each supported RDBMS:

● oc_create_database_name.sql to build tables

● oc_drop_database_name.sql to drop tables

● oc_upgrade20_database_name.sql to upgrade tables from Integration Services Release
1.x to 2.0 (does not apply to Teradata users)

● oc_upgrade61_database_name.sql to upgrade tables from Integration Services Release
2.0 to 6.1 (does not apply to Teradata users)

● oc_upgrade65_database_name.sql to upgrade tables from Integration Services Release
6.1 to 6.5

● oc_upgrade651_database_name.sql to upgrade tables from Integration Services
Release 6.5 to 6.5.1

Note:

If you need to rebuild an OLAP Metadata Catalog, you must drop (delete) the catalog tables
before you build them. Remember that if you drop an OLAP Metadata Catalog, you also
delete the OLAP models and metaoutlines that it contains.
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The utilities listed in Table 3 have been tested to work with the SQL scripts.

Table 3 SQL Scripts for Creating an OLAP Metadata Catalog  

Database SQL Script Utility Program

DB2 oc_create_db2.sql

oc_drop_db2.sql

oc_upgrade20_db2.sql

oc_upgrade61_db2.sql

oc_upgrade65_db2.sql

oc_upgrade651_db2.sql 

DB2 Command Center or >DB2 -tvf

Informix oc_create_informix.sql

oc_drop_informix.sql

oc_upgrade20_informix.sql

oc_upgrade61_informix.sql

oc_upgrade65_informix.sql

oc_upgrade651_informix.sql 

DBAccess

Oracle oc_create_oracle.sql

oc_drop_oracle.sql

oc_upgrade20_oracle.sql

oc_upgrade61_oracle.sql

oc_upgrade65_oracle.sql

oc_upgrade651_oracle.sql

oc_create_oracle_unicode.sql

oc_create_oracle9i_unicode.sql 

SQL*Plus

MS SQL Server oc_create_sqlsrv.sql

oc_drop_sqlsrv.sql

oc_upgrade20_sqlsrv.sql

oc_upgrade61_sqlsrv.sql

oc_upgrade65_sqlsrv.sql

oc_upgrade651_sqlsrv.sql 

Query Analyzer

(MS SQL Server 7.0 and 2000)

Sybase oc_create_sybase.sql

oc_drop_sybase.sql

ISQL
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Database SQL Script Utility Program

oc_upgrade20_sybase.sql

oc_upgrade61_sybase.sql

oc_upgrade65_sybase.sql

oc_upgrade651_sybase.sql 

Teradata oc_create_teradata.sql

oc_drop_teradata.sql

oc_upgrade65_teradata.sql

oc_upgrade651_teradata.sql 

BTEQ

Proper Order of SQL Scripts
If you choose to upgrade the OLAP Metadata Catalog manually, you must run the SQL scripts
in successive release order beginning with the upgrade script applicable to your current release.
This is necessary because most releases make different changes to the catalog, and changes of
one release are predicated on the changes of the preceding release. However, some releases of
Integration Services (Release 6.2 and Releases 6.5.2, 6.5.3, 6.5.4, 7.0, and 7.1) do not require any
changes to the OLAP Metadata Catalog from the immediately preceding release. No upgrade
scripts exist for these releases.

Upgrading from Integration Services Release 1.x

If you are upgrading from Release 1.x to the current release, you run the following upgrade
scripts in the order listed:

oc_upgrade20_*.sql
oc_upgrade61_*.sql
oc_upgrade65_*.sql
oc_upgrade651_*.sql

Upgrading from Integration Services Release 2.0

If you are upgrading from Release 2.0 to the current release, you run the following upgrade
scripts in the order listed:

oc_upgrade61_*.sql
oc_upgrade65_*.sql
oc_upgrade651_*.sql

Upgrading from Integration Services Release 6.1

If you are upgrading from Release 6.1 to the current release, you run the following scripts in
succession:

oc_upgrade65_*.sql
oc_upgrade651_*.sql

Upgrading from Integration Services Release 6.5
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If you are upgrading from Release 6.5 to the current release, you run the following script:

oc_upgrade651_*.sql

Caution!

After you update an OLAP Metadata Catalog, you cannot roll back to a previous version. The
new version of OLAP Metadata Catalog is not compatible with previous releases of Integration
Services. In addition, do not attempt to use the new catalog with previous releases of Integration
Services software. Such an attempt can result in corrupted OLAP Metadata Catalog data.

Upgrading Tables in the OLAP Metadata Catalog
To upgrade an OLAP Metadata Catalog manually, you upgrade the tables of the OLAP Metadata
Catalog database.

➤ To upgrade tables for the OLAP Metadata Catalog database:

1 Start the utility program.

2 Connect to the database that you created for the OLAP Metadata Catalog as the user who created the original
OLAP Metadata Catalog tables.

3 Open the appropriate SQL script file in the ocscript directory.

See “SQL Scripts Used to Create and Upgrade Tables” on page 66.

4 Run the SQL script (or scripts, if applicable) to upgrade the tables.

See “Proper Order of SQL Scripts” on page 68.

On SQL Server, you receive a message that you did not create data or rows. This message is
normal because you created only tables and columns.

5 Verify that the new tables have been added to the existing OLAP Metadata Catalog.

You can verify this by entering a command, for example:

SELECT * FROM OM_DESCRIPTION 

or, you can start the applicable RDBMS utility program and verify that the OLAP Metadata
Catalog has the new tables.

6 Close the utility program.

Mapping OLAP Metadata Catalogs
After you create an OLAP Metadata Catalog manually, you must map the catalog to a supported
ODBC driver.

For information about supported ODBC drivers, see Essbase Integration Services ODBC Support
Matrix. For information about configuring OLAP Metadata Catalog as an ODBC data source,
see Chapter 5, “Configuring Data Sources.”
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Note:

If you attempt to access an SQL Server database with the Microsoft native ODBC driver and you
do not have access permission, SQL Server connects you to the default database without notifying
you. To use Integration Services on Sybase, you must have execute permission for sp-fkeys in
Sybsystemprocs.

Deleting OLAP Metadata Catalogs
You can delete an existing OLAP Metadata Catalog at any time.

Caution!

Remember that if you delete an OLAP Metadata Catalog, you also delete the OLAP models and
metaoutlines that it contains.

➤ To delete an OLAP Metadata Catalog:

1 From either the OLAP Model or OLAP Metaoutline main window, select Tools > Create Catalog to display
the OLAP Metadata Catalog Setup dialog box, as shown in Figure 4 on page 63.

2 From the Server Name drop-down list, select the appropriate Essbase Integration Server computer.

3 From the Catalog ODBC DSN drop-down list, select the Data Source Name for the OLAP Metadata Catalog
that you want to delete.

4 In the User Name drop-down list, select or type your user name.

5 In the Password text box, type your password.

6 Click Yes to the confirmation prompt to delete the catalog.

If the OLAP Metadata Catalog that you are attempting to delete is currently in use, you are
prompted to disconnect from the current catalog (Connections > OLAP Metadata Catalog >
Disconnect). You must disconnect before you can delete the catalog.

Note:

Disconnecting from an OLAP Metadata Catalog causes the open OLAP model or metaoutline
to close.
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This chapter tells you what to consider before and after you set up the standard sample
application, whether automatically or manually. For manual setup, the topics in this chapter
detail which scripts and batch files you must run to create and load the TBC database and the
TBC_MD OLAP Metadata Catalog.

The procedures in this chapter assume that you know how to create a database using a relational
database management system (RDBMS). For manual setup, the procedures assume that you
know how to create tables and load them with data running SQL scripts, batch files, and shell
scripts. For information on these topics, see the documentation for the RDBMS that you are
using.

Overview of Sample Applications
Integration Services provides sample applications that consists of the following features:

● A database for a fictitious company called The Beverage Company (TBC)

● A sample OLAP model and metaoutline created from the TBC database

● A Hybrid Analysis-enabled OLAP model and metaoutline

● A special OLAP Metadata Catalog to store the sample OLAP models and metaoutlines and
any additional OLAP models and metaoutlines that you create using the sample data

Preparing the sample application consists of three tasks:

● Setting up the standard sample application
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● Optional: Setting up the Hybrid Analysis sample application

● Optional: Setting up the Unicode sample application

You can set up the standard sample application automatically using Integration Services Console
(see “Setting Up the Standard Sample Application Automatically” on page 73), or you can set
up the standard sample application manually (“Setting Up the Standard Sample Application
Manually” on page 75. Using either method, setting up the standard sample application
involves two main tasks:

● You create two relational databases: one for the data in the TBC sample application and one
for the OLAP Metadata Catalog database (TBC_MD).

Note:

Creating the relational databases is a manual task that you must perform prior to setting up
the standard sample application, regardless of whether you choose the automatic or manual
method.

● You then create tables in each of these databases and load data into them, using scripts
provided with Integration Services. You can create tables either automatically, through the
use of Integration Services Console, or manually.

When you finish setting up the standard sample application, the OLAP Metadata Catalog
database (TBC_MD) will contain an OLAP model (TBC Model) and a metaoutline (TBC
Metaoutline) based on data in the sample TBC relational data source.

You create the Hybrid Analysis sample application manually by completing the tasks in “Setting
Up the Hybrid Analysis Sample Application” on page 84. Upon completion of these tasks, the
sample TBC relational data source will contain Hybrid Analysis data. The OLAP Metadata
Catalog will contain a Hybrid Analysis-enabled OLAP model (HA TBC Model) and metaoutline
(HA TBC Metaoutline).

You create the Unicode sample application manually by completing the tasks in “Setting Up the
Unicode Sample Application” on page 93. Upon completion of these tasks, the sample TBC_U
relational data source will contain Unicode enabled data. The Unicode TBC_MD_U OLAP
Metadata Catalog will contain Unicode-enabled OLAP model (TBC_Model_Unicode) and
metaoutline (TBC_Metaoutline_Unicode).

Caution!

If you have installed the sample application from a previous release of Integration Services, you
should back up and preserve your existing sample database, OLAP Metadata Catalog, and the
OLAP models and metaoutlines that OLAP Metadata Catalog contains. You can then upgrade
your existing catalog to be compatible with the current release of the software (see “Upgrading
OLAP Metadata Catalogs Manually” on page 65). You cannot, however, store newly created
OLAP models and metaoutlines in your previous catalog.

72 Setting Up the Sample Applications



Preparing to Set Up the Standard Sample Application
Before you set up the standard sample application, you must install the database client software
for a supported RDBMS. When setting up the standard sample application, you must use a
computer on which the server component of Integration Services (Essbase Integration Server)
and the necessary database client software are both installed. For more information, see “About
Data Source Configuration” on page 33.

For manual setup of the standard sample application, the standard sample application scripts
do not have to be installed on the same computer that you are using, but you must be able to
access the script files.

Note:

Hyperion strongly recommends that you use the automatic installation process to install the
standard sample applications (see “Setting Up the Standard Sample Application Automatically”
on page 73).

If you are using Oracle OCI direct connection, verify that the database client software for the
RDBMS is installed. If you choose to set up the standard sample application manually, refer to
Table 4 and also verify that the appropriate client utility program is installed.

Table 4 Required Utilities for Setting Up the Standard Sample Application  

Database Utility Programs

DB2 UDB DB2 Command Window or >DB2 -tvf 

Informix DBAccess

MS SQL Server Query Analyzer (MS SQL Server 7.0 and 2000)

Oracle SQL*Plus

Sybase ● ISQL

● BCP command line utility

Teradata BTEQ

The remainder of this chapter assumes that you have installed the required database client
software.

Setting Up the Standard Sample Application Automatically
After you have completed the Integration Services installation process, you can choose to install
either or both the OLAP Metadata Catalog and the standard sample application. The system
first displays the OLAP Metadata Catalog Setup dialog box to enable automatic setup of the
catalog (see “Creating or Upgrading OLAP Metadata Catalogs Automatically” on page 63).
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Whether or not you choose to create the OLAP Metadata Catalog automatically, you can choose
to create the standard sample application automatically, after you finish creating the OLAP
Metadata Catalog. You can create the standard sample application quickly and easily using the
automatic feature. You are encouraged to use this convenient feature, but if you choose manual
setup, see “Setting Up the Standard Sample Application Manually” on page 75 for detailed
procedures.

Hybrid Analysis: If you plan to set up the sample application for Hybrid Analysis, you must
follow the procedures in “Setting Up the Hybrid Analysis Sample Application” on page 84.

Note:

ODBC connections must be configured before you begin to set up the standard sample
application. If you have not yet configured ODBC connections, see Chapter 5, “Configuring
Data Sources,” for information on setting up ODBC data sources, including an OLAP Metadata
Catalog and relational data sources.

➤ To set up the standard sample application automatically:

1 Select Tools > Create Sample to access the Sample Application Setup dialog box shown in Figure 5:

Figure 5 Sample Application Setup Dialog Box

2 In the Sample ODBC DSN text box, select or type the data source name for creating or dropping (deleting)
tables in the source database.

Oracle OCI: If you are using Oracle OCI direct connection, be sure to prefix the Net Service
Name or the Schema Name with “Oracle” by typing Oracle: and then the data source name,
as shown in Figure 3 on page 58.

The User Name text box displays the name, TBC (lowercase tbc for Informix). You must use
this name to create the TBC standard sample application database.

3 In the Password text box, type the password for the user to which you have assigned privileges to access
the TBC database for the standard sample application.
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4 Click Create to create the standard sample application.

Integration Services creates the necessary tables, loads the TBC sample data into the tables, and
loads the sample OLAP model and metaoutline data into the OLAP Metadata Catalog.

If Integration Services detects that you are not currently connected to the OLAP Metadata
Catalog in which to load the sample OLAP model and metaoutline data, the Login dialog box
is displayed so that you can enter the information necessary to connect.

After you close the Login dialog box and are returned to the Sample Application Setup dialog
box, click Create again to initiate setup of the standard sample application.

If, after clicking Create, Integration Services detects either an existing sample data source or an
existing sample OLAP model and metaoutline in the OLAP Metadata Catalog, you are prompted
with the message that tables already exist in the database. Click OK to return to the Sample
Application Setup dialog box to reenter information, or click Delete to delete the existing
standard sample application data.

If you click Delete, your existing OLAP Metadata Catalog sample OLAP models and
metaoutlines will be deleted and replaced with the sample OLAP model and metaoutline for the
current release.

After you have completed creation of the Integration Services standard sample application, you
are ready to begin working with Integration Services Console to create your own sample OLAP
models and metaoutlines (see “Starting Integration Services Console” on page 53).

Setting Up the Standard Sample Application Manually
To set up the standard sample application manually, you begin by creating two databases in a
supported RDBMS: TBC (the sample database) and TBC_MD (an OLAP Metadata Catalog).
You then create tables in each of these databases and load data into them, using scripts provided
with Integration Services. The names and directory locations of these scripts are detailed in the
topics that follow.

Note:

Hyperion strongly recommends that you use the automatic installation process to install the
standard sample applications (see “Setting Up the Standard Sample Application Automatically”
on page 73).

After you create the TBC and TBC_MD databases in a supported RDBMS, you use several scripts
and files to create the standard sample application:

● A script for creating the TBC sample database tables

This script is located in the samples\tbDVDbase directory.

● A script for loading the TBC sample database data

This script is located in the samples\tbDVDbase directory.

● A script for creating the TBC_MD OLAP Metadata Catalog database tables
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This script is located in the ocscript directory.

● XML files for importing a sample OLAP model and metaoutline in the TBC_MD OLAP
Metadata Catalog database

These XML files are located in the samples\tbcmodel directory.

The scripts for creating the standard sample application and OLAP Metadata Catalog are
installed with the server software during Integration Services installation. Different versions of
the scripts are provided for each of the supported RDBMSs.

Note:

Some of the standard sample application scripts require slightly different procedures, depending
on the RDBMS that you are using.

Setting Up the TBC Relational Data Source
The relational data source for the standard sample application is TBC.

Note:

To create a database, you must have database administrator or similar access privileges required
by the RDBMS that you are using.

➤ To set up TBC relational data source:

1 Perform the steps in “Preparing to Install Integration Services” on page 17.

2 Create the TBC database using an RDBMS.

For more information, see “Creating the TBC Database” on page 76.

3 Create tables for the TBC database by running SQL scripts.

For instructions, see “Creating Tables for the TBC Database” on page 77.

4 Load data into the TBC database by running SQL scripts.

For instructions, see “Loading Data into the TBC Tables” on page 78.

Creating the TBC Database
Create the TBC database in the same way that you create any database using an RDBMS:

● Create a database device or tablespace named TBC.

● Allot 20 MB for storage.

● Create a user TBC who can drop and create tables.

● Grant user privileges or permissions to create and drop tables.
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Caution!

The user TBC must create the tables for the TBC database, or portions of the standard sample
application will not work.

Creating Tables for the TBC Database
Create tables for the TBC database with the same utility program that you typically use to create
tables by running SQL scripts.

The standard sample application SQL scripts needed to create tables for the TBC database are
in the samples\tbDVDbase directory where you installed Integration Server.

The utilities listed in Table 5 have been tested to work with the SQL scripts:

Table 5 Tested Utilities for Creating TBC Tables  

Database SQL Script Utility Program

DB2 tbc_create_db2.sql

tbc_drop_db2.sql 

DB2 Command Window or >DB2 -tvf

Informix tbc_create_informix.sql

tbc_drop_informix.sql 

DBAccess

MS SQL Server tbc_create_sqlsrv.sql

tbc_drop_sqlsrv.sql 

Query Analyzer (MS SQL Server 7.0 and 2000)

Oracle tbc_create_oracle.sql

tbc_drop_oracle.sql 

● SQL*Plus

● SQL*Loader command line utility

Sybase tbc_create_sybase.sql

tbc_drop_sybase.sql 

ISQL

Teradata tbc_create_teradata.sql

tbc_drop_teradata.sql 

BTEQ

Each RDBMS has two scripts—one to build tables and another to drop tables.

Caution!

You must create the tables for the TBC database as user TBC, or portions of the standard sample
application will not work.

➤ To create tables for the TBC database:

1 Start the utility program.
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2 Connect to the TBC database as user TBC.

Note:

Use lowercase tbc for Informix; use uppercase TBC for Sybase and SQL Server.

3 In the samples\tbDVDbase directory, open the appropriate SQL script file.

4 Run the SQL script.

MS-SQL Server: You should receive a message that you did not create data or rows. This message
is normal because you created only tables and columns.

Informix: If you run the Informix SQL script (tbc_create_informix.sql) more than once,
you must first run tbc_drop_informix.sql to drop tables before you build them again.

5 Verify that you have created the TBC tables; for example, type

SELECT * FROM PRODUCTDIM 

or start the RDBMS and verify that the TBC database has the new tables.

6 Close the utility program.

Loading Data into the TBC Tables
Load data into the TBC tables by running an SQL script using the same utility program that you
typically use to load tables by running SQL scripts.

The utilities listed in Table 6 have been tested to work with SQL scripts.

Table 6 Tested Utilities for Loading Data into TBC Tables  

Database SQL Script Utility Program

DB2 sampledata.sql DB2 Command Window or >DB2 -tvf

Informix sampledata.sql DBAccess

MS SQL Server sampledata.sql Query Analyzer (MS SQL Server 7.0 and 2000)

Oracle sampledata.sql SQL*Plus

Sybase sampledata.sql ISQL

Teradata sampledata.sql BTEQ

➤ To load data into the TBC tables:

1 From the command line, move to the samples\tbDVDbase directory where you installed Integration
Server.

2 Start the utility program.

3 Connect to the TBC database as user TBC.

4 In the sample\tbDVDbase directory, open the sampledata.sql script file.
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5 Run the SQL script using your RDBMS tool.

6 Verify that you have loaded data into the TBC tables; for example, type

SELECT * FROM TBC.PRODUCT 

or start the RDBMS and execute a query.

7 Close the utility program.

Setting Up the TBC_MD OLAP Metadata Catalog
The OLAP Metadata Catalog for the standard sample application is TBC_MD. For more
information on OLAP Metadata Catalogs, see Chapter 7, “Creating, Upgrading, and Deleting
OLAP Metadata Catalogs.”

➤ To set up the TBC_MD OLAP Metadata Catalog:

1 Create a TBC_MD database using an RDBMS.

For more information, see “Creating the TBC_MD Database” on page 79.

2 Create tables for the TBC_MD database by running SQL scripts.

For instructions, see “Creating Tables for the TBC_MD Database” on page 80.

3 Load data into the TBC_MD database using the XML import utility.

For instructions, see “Using the XML Import Utility to Load Data into the TBC_MD Tables”
on page 82.

Note:

If you have a previous release of Integration Services and are upgrading your OLAP Metadata
Catalog, you cannot roll back to the previous version. The new version of the OLAP Metadata
Catalog is not compatible with earlier releases of Integration Services.

Creating the TBC_MD Database
Create the TBC_MD database in the same way that you create any database using an RDBMS:

● Create a database device or tablespace named TBC_MD.

● Allot 20 MB for storage.

● Create a user TBC who can drop and create tables.

● Grant user privileges or permissions.

Caution!

You must create the tables for the TBC_MD database as user TBC or portions of the standard
sample application will not work.
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Creating Tables for the TBC_MD Database
Create tables for the TBC_MD database with the same utility program that you typically use.

The standard sample application SQL scripts used to create tables for the TBC_MD database are
in the ocscript directory where you installed Integration Server.

The SQL scripts in the ocscript directory are the same scripts that you use to create any OLAP
Metadata Catalog. For information on OLAP Metadata Catalogs, see Chapter 7, “Creating,
Upgrading, and Deleting OLAP Metadata Catalogs.”

The utilities listed in Table 7 have been tested to work with the SQL scripts:

Table 7 Tested Utilities for Creating TBC_MD Tables  

Database SQL Script Utility Program

DB2 oc_create_db2.sql

oc_drop_db2.sql

oc_upgrade20_db2.sql

oc_upgrade61_db2.sql

oc_upgrade65_db2.sql

oc_upgrade651_db2.sql 

DB2 Command Center or >DB2 -tvf

Informix oc_create_informix.sql

oc_drop_informix.sql

oc_upgrade20_informix.sql

oc_upgrade61_informix.sql

oc_upgrade65_informix.sql

oc_upgrade651_informix.sql 

DBAccess

MS SQL Server oc_create_sqlsrv.sql

oc_drop_sqlsrv.sql

oc_upgrade20_sqlsrv.sql

oc_upgrade61_sqlsrv.sql

oc_upgrade65_sqlsrv.sql

oc_upgrade651_sqlsrv.sql 

Query Analyzer (MS SQL Server 7.0 and 2000)

Oracle oc_create_oracle.sql

oc_drop_oracle.sql

oc_upgrade20_oracle.sql

oc_upgrade61_oracle.sql

SQL*Plus
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Database SQL Script Utility Program

oc_upgrade65_oracle.sql

oc_upgrade651_oracle.sql

oc_create_oracle_unicode.sql

oc_create_oracle9i_unicode.sql

Sybase oc_create_sybase.sql

oc_drop_sybase.sql

oc_upgrade20_sybase.sql

oc_upgrade61_sybase.sql

oc_upgrade65_sybase.sql

oc_upgrade651_sybase.sql

ISQL

Teradata oc_create_teradata.sql

oc_drop_teradata.sql

oc_upgrade65_teradata.sql

oc_upgrade651_teradata.sql

BTEQ

Note:

The scripts used to upgrade OLAP Metadata Catalog manually from Release 2.0 to Release 6.2
are identical to those used to upgrade from Release 2.0 to Release 6.1. Therefore, the names have
not been changed from the names used in Integration Services Release 6.1. If you are upgrading
OLAP Metadata Catalog from Release 2.0 to Release 6.2, use the scripts named *61*.sql that are
appropriate for your RDBMS.

Integration Services provides five SQL scripts for each RDBMS (with the exception of Teradata):

● oc_create_database_name.sql to build tables

● oc_drop_database_name.sql to drop tables

● oc_upgrade20_database_name.sql to upgrade tables from Integration Services Release
1.x to 2.0 (does not apply to Teradata users)

● oc_upgrade61_database_name.sql to upgrade tables from Integration Services Release
2.0 to 6.2 (does not apply to Teradata users)

● oc_upgrade65_database_name.sql to upgrade tables from Integration Services Release
6.1 or 6.2 to 6.5

● oc_upgrade651_database_name.sql to upgrade tables from Integration Services
Release 6.5 to 6.5.1

If you need to rebuild tables, you must first drop the tables before you build them again.
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Caution!

You must create the tables for the TBC_MD database as user TBC or portions of the standard
sample application will not work.

➤ To create tables for the TBC_MD database:

1 Start the utility program.

2 Connect to the TBC_MD database as user TBC.

3 In the ocscript directory, open the appropriate SQL script file.

4 Run the SQL script.

MS-SQL Server: You receive a message that you did not create data or rows. This message is
normal because you created only tables and columns.

5 Verify that you have created the TBC_MD tables; for example, type the following command:

SELECT * FROM TBC.MS_INFO 

or start the RDBMS and verify that the TBC_MD database has the new tables.

6 Close the utility program.

Using the XML Import Utility to Load Data into the TBC_MD
Tables
Use the XML Import utility to load OLAP model and metaoutline data into the TBC_MD tables.

The XML files listed in Table 8 have been tested to work with their respective RDBMS. These
files are located in the samples\tbcmodel directory.

Table 8 XML Files for Loading Data into TBC_MD Tables  

Database XML File in sample\tbcmodel

● DB2

● Oracle

● MS SQL Server

● Sybase

● Teradata

sample_model.xml

sample_metaoutline.xml 

Informix sample_model_informix.xml

sample_metaoutline.xml

Using XML Import to Load Metadata into TBC_MD
To complete the procedure below, you must start Integration Services Console and connect to
Integration Server.
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➤ To start Integration Services Console and connect to Integration Server:

1 On the Windows desktop, click Start, and select Programs > Hyperion > Integration Services > Integration
Server.

For more information on startup and connection procedures, see “Connecting to Integration
Server” on page 54, and “Connecting to Essbase Server” on page 55.

2 On the Windows desktop, click Start, and select Programs > Hyperion > Integration Services > Integration
Services Console.

3 If necessary, click Close to clear the OLAP Metadata Catalog Setup dialog box.

Integration Services Console automatically displays the Login dialog box.

a. In the Server text box, under Integration Services, select or type the name of an Integration
Server computer; for example, cypress.

If the port number on which Essbase Integration Server communicates with the console
has been set to a value other than the default, you must type the server name or IP address
and type the non-standard port number, separated by a colon; for example:

   cypress:3390

b. In the OLAP Metadata Catalog text box, select or type the name of the OLAP Metadata
Catalog, TBC_MD, for the sample TBC (The Beverage Company) database.

Oracle OCI: If you are using Oracle OCI direct connection, be sure to prefix the Net Service
Name or the Schema Name with “Oracle” by typing Oracle: and then the data source
name, as shown in Figure 3 on page 58.

c. In the User Name and Password text boxes, type the user name and password for the
standard sample application user, TBC, and click OK.

➤ To load sample OLAP model metadata into the TBC_MD tables using XML Import:

1 In Integration Services Console, select File > XML Import/Export.

2 Select the Import tab.

3 In the XML File Path text box, enter the file path for the sample OLAP model or click the Open XML File
button and navigate to the following folder:

\AIS\samples\tbcmodel

4 Select the XML file to import for the sample OLAP model, sample_model.xml.

Informix: Select the XML file to import for the sample OLAP model for Informix,
sample_model_informix.xml.

5 Click OK.

Integration Services Console displays the XML Import/Export dialog box with the XML file path
and name in the XML File Path text box. The name of the sample OLAP model is displayed in
the OLAP Model Name text box.

6 Click the Import to Catalog button to load the selected XML file into the sample OLAP Metadata Catalog.
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➤ To load sample OLAP metaoutline metadata into the TBC_MD tables using XML Import:

1 In Integration Services Console, select File > XML Import/Export.

2 Select the Import tab.

3 In the XML File Path text box, enter the file path for the sample OLAP metaoutline or click the Open XML
File button and navigate to the following file:

\AIS\samples\tbcmodel

4 Select the XML file to import for the sample OLAP metaoutline, sample_metaoutline.xml.

5 Click OK.

Integration Services Console displays the XML Import/Export dialog box with the XML file path
and name in the XML File Path text box, the name of the sample OLAP metaoutline in the OLAP
Metaoutline Name text box, and the name of the OLAP model upon which this metaoutline is
based in the Based on OLAP Model text box.

6 Click the Import to Catalog button to load the selected XML file into the sample OLAP Metadata Catalog.

Setting Up the Hybrid Analysis Sample Application
Before setting up the Hybrid Analysis sample application, you must set up the standard sample
application (see “Setting Up the Standard Sample Application Automatically” on page 73 or
“Setting Up the Standard Sample Application Manually” on page 75.)

Setting up the Hybrid Analysis sample application is a manual process. Follow the instructions
given in this section for your particular platform.

Note:

The Hybrid Analysis application scripts require slightly different procedures, depending on the
RDBMS that you are using.

The utilities listed in Table 5 are required for running the various batch files and SQL scripts
used in creating the Hybrid Analysis sample application.

Table 9 Required Utilities for Setting Up the Hybrid Analysis Sample Application 

Database Required Utilities

DB2 DB2CMD command line interface

Oracle ● SQL*Plus

● SQL*Loader command line utility

MS SQL Server ● ISQL

● BCP command line utility

Teradata ● BTEQ

● FastLoad
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Setting Up the Hybrid Analysis Sample Application on DB2
You use several files to create the Hybrid Analysis sample application on DB2:

● A batch file to send commands to the DB2CMD command line interface:

   install_db2.bat

● A data load script for the TBC sample database:

   ha_create_db2.sql

● An XML file that you use to import a sample OLAP model into the TBC_MD OLAP
Metadata Catalog database:

   HA_TBC_Model.xml

● An XML file that you use to import a sample metaoutline into the TBC_MD OLAP Metadata
Catalog database:

   HA_TBC_Metaoutline.xml 

● A text file containing sample data:

   ha_sampledata.txt

Setting up the Hybrid Analysis sample application on DB2 consists of performing the following
tasks:

● Running the batch file install_db2.bat

● Importing the sample OLAP model and metaoutline

Note:

Before setting up the Hybrid Analysis Sample Application on DB2, verify that the DB2CMD
command line interface is installed.

Running the Batch File on DB2
The first task in setting up the Hybrid Analysis sample application on DB2 consists of running
the install_db2.bat file. This batch file creates tables in the sample database, loads metadata
into the dimension tables, and loads sample data into the fact table.

Run the install_db2.bat file located in:

\AIS\Samples\tbDVDbase 

This batch file sends SQL commands to the DB2CMD command line interface.

Pass the following three parameters to install_db2.bat:

● The user ID that you use to connect with DB2

● Your password

● The DB2 database name

The install_db2.bat file runs the DB2CMD command line interface, which executes the
ha_create_db2.sql load script file. This script file performs the following tasks:

● Deletes any existing tables in the sample TBC database
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● Creates a new set of tables in the TBC database

● Inserts records into the dimension tables

● Creates the ha_results_createtables.txt file

● Loads the sample data into the fact table

The ha_results_createtables.txt file contains the results of the table-creating and
loading operations.

Note:

After the member and data load is finished, close the DB2 command window.

Importing the Sample OLAP Model and Metaoutline
The final task in setting up the Hybrid Analysis sample application on DB2 consists of importing
the two XML files for the sample OLAP model and metaoutline:

➤ To import the sample OLAP model:

1 Start Integration Services Console.

2 Select File > XML Import/Export.

The XML Import/Export window is displayed.

3 Select the Import tab.

4 In the XML File Path text box, enter the file path for the sample OLAP model or click the Open XML File
button and navigate to the following file:

\AIS\samples\tbcmodel\HA_TBC_Model.xml

5 Click Open XML File.

➤ To import the sample metaoutline:

1 Select File > XML Import/Export.

The XML Import/Export window is displayed.

2 Select the Import tab.

3 In the XML File Path text box, enter the file path for the sample OLAP metaoutline or click the Open XML
File button and navigate to the following file:

\AIS\samples\tbcmodel\HA_TBC_Metaoutline.xml

4 Click Open XML File.

Setting Up Hybrid Analysis Sample Application on Oracle
You use several files to create the Hybrid Analysis sample application on Oracle:

● A batch file to send commands to the SQLPLUS command line interface:
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   install_oracle.bat

● A data load script for the TBC sample database:

   ha_create_oracle.sql

● An Oracle control file to load data into the fact table:

   hasales.ctl

● An XML file that you use to import a sample OLAP model into the TBC_MD OLAP
Metadata Catalog database:

   HA_TBC_Model.xml

● An XML file you use to import a sample metaoutline into the TBC_MD OLAP Metadata
Catalog database:

   HA_TBC_Metaoutline.xml

● A text file containing sample data:

   ha_sampledata.txt

Setting up the Hybrid Analysis sample application on Oracle consists of performing the following
tasks:

● Running the batch file install_oracle.bat

● Importing the sample OLAP model and metaoutline

Note:

Before setting up the Hybrid Analysis Sample Application on Oracle, verify that SQL*PLUS
and SQLLDR command line interfaces are installed.

Running the Batch File
The first task in setting up the Hybrid Analysis sample application on Oracle consists of running
the install_oracle.bat file. This batch file creates tables in the sample database, loads
metadata into the dimension tables, and loads sample data into the fact table.

Run the install_oracle.bat file located in:

\AIS\samples\tbDVDbase 

This batch file sends SQL commands to the SQL*PLUS command line interface.

Pass the following three parameters to install_oracle.bat :

● The user ID that you use to connect with Oracle

● Your password

● The Oracle service name as defined in the TNSNAMES.ORA file

Metadata Load Script

The install_oracle.bat file runs the SQLPLUS command line interface, which executes the
ha_create_oracle.sql metadata load script file. This script file performs the following tasks:

Setting Up the Hybrid Analysis Sample Application 87



● Deletes any existing tables in the sample TBC database

● Creates a new set of tables in the TBC database

● Inserts records into the dimension tables

● Creates the ha_results_createtables.txt file

The ha_results_createtables.txt file contains the results of the table-creating operation.

Sample Data Load Script

After loading the metadata into the dimension tables, the install_oracle.bat file runs the
SQLLDR command line interface, which performs the following tasks:

● Loads the sample data into the fact table

● Creates the ha_results_loadfact.txt file

The ha_results_loadfact.txt file contains the results of the data-loading operation.

Importing the Sample OLAP Model and Metaoutline
The final task in setting up the Hybrid Analysis sample application on Oracle consists of
importing the two XML files for the sample OLAP model and metaoutline:

➤ To import the sample OLAP model:

1 Start Integration Services Console.

2 Select File > XML Import/Export.

The XML Import/Export dialog box is displayed.

3 Select the Import tab.

4 In the XML File Path text box, enter the file path for the sample OLAP model or click the Open XML File
button and navigate to the following file:

\AIS\samples\tbcmodel\HA_TBC_Model.xml 

5 Click Open XML File.

➤ To import the sample metaoutline:

1 Select File > XML Import/Export.

The XML Import/Export dialog box is displayed.

2 Select the Import tab.

3 In the XML File Path text box, enter the file path for the sample OLAP metaoutline or click the Open XML
File button and navigate to the following file:

\AIS\Samples\tbcmodel\HA_TBC_Metaoutline.xml 

4 Click Open XML File.
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Setting Up Hybrid Analysis Sample Application on SQL Server
Several files are used to create the Hybrid Analysis sample application on SQL Server:

● A batch file to send commands to MS Interface SQL (ISQL):

   install_sqlsrv.bat 

● A data load script for the TBC sample database:

   ha_create_sqlsrv.sql 

● An XML file that you use to import a sample OLAP model into the TBC_MD OLAP
Metadata Catalog database:

   HA_TBC_Model.xml 

● An XML file that you use to import a sample metaoutline into the TBC_MD OLAP Metadata
Catalog database:

   HA_TBC_Metaoutline.xml 

● A text file containing sample data:

   ha_sampledata.txt 

Setting up the Hybrid Analysis sample application on SQL Server consists of performing the
following tasks:

● Running the install_sqlsrv.bat batch file

● Importing the sample OLAP model and metaoutline

Note:

Before setting up the Hybrid Analysis Sample Application on SQL Server, verify that you
have ISQL and BCP (Bulk Copy) installed. These utilities were most likely included when
you installed SQL Server Client.

Running the Batch File
To set up the Hybrid Analysis sample application on SQL Server, you first run the
install_sqlsrv.bat file. This batch file creates tables in the sample database, loads metadata
into the dimension tables, and loads sample data into the fact table. Run the
install_sqlsrv.bat file located in:

\AIS\Samples\tbDVDbase

This file sends commands to the Interface SQL (ISQL) command line interface. These commands
install the sample application to the sample database TBC.

Pass the following three parameters to install_sqlsrv.bat:

● The user ID that you use to connect with the SQL Server (TBC)

● Your password

● The SQL Server name (name of machine where the SQL Server is installed)
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Metadata Load Script

The install_sqlsrv.bat file runs the ISQL utility, which executes the
ha_create_sqlsrv.sql metadata load script file. This file performs the following tasks:

● Deletes any existing tables in the sample TBC database

● Creates a new set of tables in the TBC database

● Inserts records into the dimension tables

● Creates the ha_results_createtables.txt file

The ha_results_createtables.txt file contains the results of the table-creating operation.

Sample Data Load Script

After loading the metadata into the dimension tables, the install_sqlsrv.bat file runs the
BCP (Bulk Copy) utility which performs the following tasks:

● Loads the sample data into the fact table

● Creates the ha_results_loadfact.txt file

The ha_results_loadfact.txt file contains the results of the data-loading operation.

Importing the Sample OLAP Model and Metaoutline
The final task in setting up the Hybrid Analysis sample application on SQL Server consists of
importing the two XML files for the sample OLAP model and metaoutline:

➤ To import the sample OLAP model:

1 Start Integration Services Console.

2 Select File > XML Import/Export.

The XML Import/Export dialog box is displayed.

3 Select the Import tab.

4 In the XML File Path text box, enter the file path for the sample OLAP model or click the Open XML File
button and navigate to the following file:

\AIS\samples\tbcmodel\HA_TBC_Model.xml 

5 Click Open XML File.

➤ To import the sample metaoutline:

1 Select File > XML Import/Export.

The XML Import/Export dialog box is displayed.

2 Select the Import tab.

3 In the XML File Path text box, enter the file path for the sample OLAP metaoutline or click the Open XML
File button and navigate to the following file:
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\AIS\Samples\tbcmodel\HA_TBC_Metaoutline.xml 

4 Click Open XML File.

Setting Up Hybrid Analysis Sample Application on Teradata
Several files create the Hybrid Analysis sample application on Teradata:

● A batch file to send commands to MS Interface SQL (ISQL):

   install_teradata.bat 

● A data load script for the TBC sample database:

   ha_create_teradata.sql 

● An SQL file to add constraints to the fact table after the data load has been completed:

   ha_altertable_teradata.sql 

● A FastLoad script file, which loads data to the fact table:

   ha_fastload_teradata.sql 

● An XML file that you use to import a sample OLAP model into the TBC_MD OLAP
Metadata Catalog database:

   HA_TBC_Model.xml 

● An XML file that you use to import a sample metaoutline into the TBC_MD OLAP Metadata
Catalog database:

   HA_TBC_Metaoutline.xml 

● A text file containing sample data:

   ha_sampledata.txt 

Setting up the Hybrid Analysis sample application on SQL Server consists of performing the
following tasks:

● Running the batch file install_teradata.bat

● Importing the sample OLAP model and metaoutline

Note:

Before setting up the Hybrid Analysis Sample Application on Teradata, verify that the BTEQ
and FastLoad utilities are installed.

Running the Batch File
The first task in setting up the Hybrid Analysis sample application on Teradata consists of
running the install_teradata.bat file. This batch file creates tables in the sample database,
loads metadata into the dimension tables, loads sample data into the fact table, and adds
constraints to the fact table.

Run the install_teradata.bat file located in:

\AIS\Samples\tbDVDbase 
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This batch file sends SQL commands to the BTEQ command line interface.

Pass the following three required parameters to install_teradata.bat:

● The user ID that you use to connect with Teradata

● Your password

● The Teradata database name (DBC)

You can also pass, as an optional parameter, the database name where you want to install the
sample application. (The default database is TBC.)

Metadata Load Script

The install_teradata.bat file runs the BTEQ utility, which executes the
ha_create_teradata.sql metadata load script file. This script file performs the following
tasks:

● Deletes any existing tables in the sample TBC database

● Creates a new set of tables in the TBC database

● Inserts records into the dimension tables

● Creates the ha_results_createtables.txt file

The ha_results_createtables.txt file contains the results of the table-creating operation.

Sample Data Load Script

After loading the metadata into the dimension tables, the install_teradata.bat file runs
the FastLoad utility, which performs the following tasks:

● Loads the sample data into the fact table using the ha_fastload_teradata.txt file

● Creates the ha_results_loadfact.txt file

The ha_results_loadfact.txt file contains the results of the data-loading operation.

Alter Table Script

After loading the sample data into the fact table, the install_teradata.bat file runs the
BTEQ utility, which executes the ha_altertable_teradata.sql alter table script file. This
script file performs the following tasks:

● Deletes a few tables no longer needed in the sample TBC database

● Creates indexes and places constraints on the fact table

● Creates the ha_results_altertables.txt file

The ha_results_altertables.txt file contains the results of the table-altering operation.
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Importing the Sample OLAP Model and Metaoutline
The final task in setting up the Hybrid Analysis sample application on Teradata consists of
importing the two XML files for the sample OLAP model and metaoutline:

➤ To import the sample OLAP model:

1 Start Integration Services Console.

2 Select File>XML Import/Export.

The XML Import/Export window is displayed.

3 Select the Import tab.

4 In the XML File Path text box, enter the file path for the sample OLAP model or click the Open XML File
button and navigate to the following file:

\AIS\Samples\tbcmodel\HA_TBC_Model.xml

5 Click Open XML File.

➤ To import the sample metaoutline:

1 Select File>XML Import/Export.

The XML Import/Export window is displayed.

2 Select the Import tab.

3 In the XML File Path text box, enter the file path for the sample OLAP metaoutline or click the Open XML
File button and navigate to the following file:

\AIS\Samples\tbcmodel\HA_TBC_Metaoutline.xml 

4 Click Open XML File.

Setting Up the Unicode Sample Application
Setting up the Unicode sample application is a manual process.

Note:

The Unicode sample application in Integration Services is supported only on Oracle relational
database management systems (RDBMSs).

The utilities listed in Table 10 are required for running the various batch files and SQL scripts
used in creating the Unicode sample application.

Table 10 Required Utilities for Setting Up the Unicode Sample Application 

Database Required Utilities

Oracle ● SQL*Plus

● SQL*Loader command line utility
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Creating the Unicode TBC_U Database
Create the Unicode TBC_U database in the same way that you create any database using an
RDBMS:

● Create a database device or tablespace named TBC_U.

● Allot 20 MB for storage.

● Create a user TBC_U who can drop and create tables.

● Grant user privileges or permissions to create and drop tables.

Caution!

You should create the tables for the Unicode-enabled database as user TBC_U, or portions
of the Unicode sample application may not work.

Creating the Unicode TBC_MD_U OLAP Metadata Catalog
Create the Unicode TBC_MD_U OLAP Metadata Catalog by following the steps in “Setting Up
the TBC_MD OLAP Metadata Catalog” on page 79, using the file oc_create_
database_name_unicode.sql.

Setting Up the Unicode Sample Application

Note:

The Unicode sample application in Integration Services is supported only on Oracle relational
database management systems (RDBMSs).

You use several files to create the Unicode sample application:

● A table creation and data load script for the Unicode sample database:

   tbc_create_database_name_unicode.sql

● An XML file that you use to import a sample OLAP model into the TBC_MD_Unicode
OLAP Metadata Catalog database:

   TBC_Model_Unicode.xml

● An XML file that you use to import a sample metaoutline into the TBC_MD_Unicode OLAP
Metadata Catalog database:

   TBC_Metaoutline_Unicode.xml

Setting up the Unicode sample application consists of performing the following tasks:

● Running the SQL file tbc_create_database_name_unicode.sql

● Importing the Unicode sample model

● Importing the Unicode sample metaoutline
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Running the SQL File
The first task in setting up the Unicode sample application consists of running the
tbc_create_database_name_unicode.sql file using one of the utilities listed in Table 10 on page
93.

Note:

Ensure you have created a Unicode-enabled database for your sample application as described
in “Creating the Unicode TBC_U Database” on page 94.

Run the tbc_create_database_name_unicode.sql file located in: 

samples\tbDVDbase\ 

The tbc_create_database_name_unicode.sql file performs the following tasks:

● Deletes any existing tables in the Unicode sample database

● Creates a new set of tables in the Unicode sample database

● Loads Unicode sample metadata into the dimension tables

● Loads Unicode sample data into the fact table

Importing the Unicode Sample Model and Metaoutline
The final task in setting up the Unicode sample application consists of importing the XML file
for the Unicode sample model:

➤ To import the Unicode sample OLAP model:

1 Start Integration Services Console and log in to the Unicode catalog.

2 Select File>XML Import/Export.

The XML Import/Export dialog box is displayed.

3 Select the Import tab.

4 In the XML File Path text box, enter the file path for the Unicode sample OLAP model or click the Open XML
File button and navigate to the following file:

AIS\samples\tbcmodel\TBC_Model_Unicode.xml 

5 Select the file and click Import to Catalog.

A message is displayed when the import is complete.

6 Click OK.

➤ To import the Unicode sample metaoutline:

1 If necessary, select File>XML Import/Export.

The XML Import/Export dialog box is displayed.
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2 Select the Import tab.

3 In the XML File Path text box, enter the file path for the Unicode sample metaoutline or click the Open XML
File button and navigate to the following file:

\AIS\Samples\tbcmodel\TBC_Metaoutline_Unicode.xml

4 Select the file and click Import to Catalog.

A message is displayed when the import is complete.

5 Click OK.

6 Click Close to close the XML Import/Export dialog box.

After Setting Up the Sample Application
You must connect to both TBC and TBC_MD from Integration Services Console to create,
modify, and store TBC OLAP models and TBC metaoutlines. To make these connections, each
database (TBC and TBC_MD) must be mapped to a supported ODBC driver, as described in
Chapter 5, “Configuring Data Sources.”

When you connect to Integration Services Console, you can view TBC columns, tables, OLAP
models, and metaoutlines in Integration Services Console. For more information, see “Viewing
TBC Tables and Columns ” on page 96.

For a quick reference to where you are in the installation process, see “Preparing to Install
Integration Services” on page 17.

Note:

You must connect to TBC and TBC_MD as user TBC unless you create user name aliases or
synonyms in the RDBMS. For more information, see “Creating Database User Aliases and
Synonyms” on page 111.

Viewing TBC Tables and Columns 
After you set up the sample application and configure TBC and TBC_MD by mapping them to
supported ODBC drivers, you can view TBC tables and columns in Integration Services Console.

➤ To see TBC tables and columns in the left frame of Integration Services Console:

1 Start Integration Server.

2 Start Integration Services Console.

For instructions, see “Starting Integration Services Console” on page 53.

3 In a blank Integration Services Console window, select Connections > OLAP Metadata Catalog >
Connect, and connect to the OLAP Metadata Catalog, TBC_MD.

4 In the New tab, double-click the OLAP Model icon.

5 In the Data Source dialog box, connect to the TBC sample database.

96 Setting Up the Sample Applications



Viewing OLAP Models
After you set up the sample application and configure TBC and TBC_MD by mapping them to
supported ODBC drivers, you can view OLAP models in Integration Services Console.

➤ To see the OLAP model (TBC Model) in the right frame of Integration Services Console:

1 Start Integration Server.

2 Start Integration Services Console.

For instructions, see “Starting Integration Services Console” on page 53.

3 If the Login dialog box is not already displayed, in a blank Integration Services Console window, select
Connections > OLAP Metadata Catalog > Connect.

4 Connect to the OLAP Metadata Catalog TBC_MD.

5 Click the Existing tab, select TBC Model, and click Open.

Hybrid Analysis: To view the Hybrid Analysis-enabled OLAP model, select HA TBC Model.

Duplicate Member (Oracle only): To view the Duplicate Member-enabled OLAP model, select
Duplicate Member TBC Model.

6 In the Data Source dialog box, connect to the TBC sample database.

Viewing Metaoutlines
After you set up the sample application and configure TBC and TBC_MD by mapping them to
supported ODBC drivers, you can view metaoutlines in Integration Services Console.

➤ To see the metaoutline (TBC Metaoutline) in the right frame of Integration Services Console:

1 Start Integration Server.

2 Start Integration Services Console.

For instructions, see “Starting Integration Services Console” on page 53.

3 If the Login dialog box is not already displayed, in a blank Integration Services Console window, select
Connections > OLAP Metadata Catalog > Connect.

4 Connect to the OLAP Metadata Catalog TBC_MD.

5 Click the Existing tab, then click the plus symbol (+) to the left of TBC Model to expand the view, and select
TBC Metaoutline.

Hybrid Analysis: To view the Hybrid Analysis-enabled metaoutline, click the plus symbol (+)
to the left of HA TBC Model to expand the view, and select HA TBC Metaoutline.

Duplicate Member (Oracle only): To view the Duplicate Member-enabled metaoutline, click
the plus symbol (+) to the left of Sample_duplicate member to expand the view, and select
Duplicate Member TBC Metaoutline.

6 Click Open.
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The Data Source dialog box is displayed.

7 In the Data Source dialog box, connect to the TBC sample database.
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This chapter contains information about changes made by the Integration Services installation
program, procedures for advanced installation tasks, and a checklist for installation
troubleshooting.

Note:

The instructions for manually updating the UNIX environment in this chapter are mandatory
for proper installation of Integration Services on UNIX systems.

What Happens During Installation
When you install Integration Services software, the installation program creates directories and
copies program files, scripts, and documentation files to the local drive. In addition, the
installation program makes changes to the operating system environment, such as environment
variable settings.

The specific changes made to the computer depend on the operating system (Windows or
UNIX), whether you are installing server or client software, and which components of
Integration Services you choose to install.

Note:

On UNIX systems, the installation program prepares shell scripts for setting environment
variables and you must manually add these to the login scripts.
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Server Installations on Windows Systems
When you install the Integration Services server software on Windows computers, the
installation program performs the these actions: Creates a new directory and several
subdirectories on the local drive.

By default, setup creates the following directory for the software:

C:\Hyperion\AIS

Note:

During installation, you can create a different directory, but you cannot change the
subdirectories.

If you install client and server software on the same computer, you must install all of them in
the same directory.

For a listing of the subdirectories created and an explanation of their purpose, see Table 11.

● Copies program files, scripts, and documentation to the created directories on the local drive

● Copies shared library files to the Windows system directory

● Updates the Windows operating environment:

❍ Sets the ISHOME, ARBORPATH, ISLOADINFO, and HYPERION_HOME
environment variables

❍ Updates the PATH environment variable

❍ Adds entries to the Windows Registry for Integration Services

Table 11 and Table 12 lists the directory structure that the Integration Services installation
program creates for a server installation on Windows:

Table 11 Directories Created for Server Installation on Windows  

Directory Structure Description

\Hyperion\AIS\ 

 batch Empty. Later, the batch directory will store scheduler scripts for batch jobs you create.

 bin Contains Essbase Integration Server and Essbase Integration Services Shell software. Also
contains the ais.cfg file and error.txt file. If you install client software, the Essbase
Integration Services Console software is in the bin directory.

 docs PDF documentation:

● Essbase Integration Services New Features

● Essbase Integration Services Installation Guide

● Essbase Integration Services ODBC Support Matrix

● Essbase Integration Services Data Preparation Guide

● Essbase Integration Services System Administrator's Guide

● Essbase Integration Services OLAP Model Document Type Definition
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Directory Structure Description

● Essbase Integration Services OLAP Metaoutline Document Type Definition

HTML documentation:

Essbase Integration Services Information Map

 esscript Empty. Later, the esscript directory will contain ESSCMD scripts you create.

 loadinfo Empty. Later, the loadinfo directory will contain folders representing session IDs, which will
contain the reject files created during a member load or data load.

 locale Integration Services national language support files.

 log Contains the server log file, olapisvr.log, which is created when you first run Integration
Server.

 ocscript SQL script files to create, drop, and upgrade tables for an OLAP Metadata Catalog in each of the
supported databases. For example, you can use oc_create_db2.sql to create OLAP Metadata
Catalog tables in a DB2 database.

 samples Three subdirectories:

samples\spreadsheets 

samples\tbDVDbase 

samples\tbcmodel 

 samples\spreadsheets Sample Essbase spreadsheets in Excel formats

 samples\tbDVDbase SQL script files and batch files to create tables and load data for the standard TBC sample
application database, the Hybrid Analysis-enabled TBC sample application database, and the
Unicode-enabled TBC_U sample application database.

SQL script files and batch files to load data for the standard OLAP model (TBC Model) and
metaoutline (TBC Metaoutline) and the Hybrid Analysis-enabled OLAP model (HA TBC Model) and
metaoutline (HA TBC Metaoutline) in the TBC_MD sample application OLAP Metadata Catalog
database.

SQL script files to load data for the Unicode OLAP model (Sample_unicode) and metaoutline
(Sample_unicode_meta) in the TBC_MD_U sample application OLAP Metadata Catalog
database.

For manual sample application setup, you create tables for TBC_MD and TBC_MD_U with SQL
script files in the ocscript directory. For more information, see Chapter 8, “Setting Up
the Sample Applications.”

 samples\tbcmodel XML files to load data for the standard OLAP model (TBC Model) and metaoutline (TBC
Metaoutline) and the Hybrid Analysis-enabled OLAP model (HA TBC Model) and metaoutline (HA
TBC Metaoutline) in the TBC_MD sample application OLAP Metadata Catalog database.

(Oracle only) XML files to load data for the Unicode OLAP model (Sample_unicode) and
metaoutline (Sample_unicode_meta) in the TBC_MD_U sample application OLAP Metadata
Catalog database.

Table 12 Directories Created for Common Files on Windows 

Directory Structure Description

\%HYPERION_HOME%\common\ 
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Directory Structure Description

 JRE Contains the Java Runtime Environment (JRE 1.4.2) folder, binary files for compiled Java
code, and support files for the XML Import/Export functionality.

 ODBC\Merant\5.0 Readme file containing latest DataDirect ODBC information, and the subdirectories:

Merant\5.0\docs

 ODBC\Merant\5.0\Docs DataDirect ODBC PDF documentation.

 ODBC\Merant\5.0\Drivers DataDirect ODBC library files.

Client Installations on Windows Systems
When you install the Integration Services client software on Windows computers, the installation
program performs these actions: Creates a new directory and several subdirectories on the local
drive.

By default, setup creates the following directory for client software:

C:\Hyperion\AIS

If you install client and server software on the same computer, you must install them all in the
same directory.

Note:

During installation, you can choose to create a different directory, but you cannot change the
subdirectories.

For a listing of the subdirectories and their purpose, see Table 13.

● Copies program files, scripts, and documentation to the created directories on the local drive

● Copies shared library files to the Windows system directory

● Updates the Windows operating environment:

❍ Sets the ARBORPATH and ISHOME environment variables

❍ Updates the PATH environment variable

❍ Adds entries to the Windows Registry for Integration Services

Installing the sample application and the OLAP Metadata Catalog scripts results in additional
directories.

Table 13 lists the directory structure that the Integration Services installation program creates
for client installations on Windows systems:

Table 13 Directories Created for Client Installation on Windows  

Directory Structure Description
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\Hyperion\AIS\

 bin Essbase Integration Services Console and Essbase Integration Services Shell software. Also contains the 
error.txt file.

 docs PDF documentation:

● Essbase Integration Services New Features

● Essbase Integration Services Installation Guide

● Essbase Integration Services ODBC Support Matrix

● Essbase Integration Services Data Preparation Guide

● Essbase Integration Services System Administrator's Guide

● Essbase Integration Services OLAP Model Document Type Definition

● Essbase Integration Services OLAP Metaoutline Document Type Definition

HTML documentation:

Essbase Integration Services Information Map

 locale Integration Services national language support files.

 log Contains the server log file, olapisvr.log, which is created when you first run Essbase Integration Server.

Enabling Regional Options for Multiple Languages
When you enable the appropriate languages in Windows, Integration Services Console can
display OLAP model and metaoutline elements in the languages of the source database.
Integration Services Console uses the settings you configure in Windows to display languages.

Enabling Regional Options in Windows 2000

➤ To enable the Regional Options for languages in Windows 2000:

1 In the Windows taskbar, select Start > Settings > Control Panel and double-click Regional Options.

The General tab of the Regional Options dialog box is displayed.

2 In the Your locale (location) drop-down list, select the appropriate locale.

In most cases, you set the locale to match your location.

3 In the Language settings for the system frame, select the languages that you want to display on the
Integration Services Console computer.

For example, you may select Cyrillic to display Russian characters or Simplified Chinese and
Traditional Chinese to display Chinese characters.

4 If the languages that you need do not appear in the Language settings for the system frame, or if you want
to attach a specific code page to a language, click the Advanced button and perform the following tasks:

a. In the Advanced Regional Options dialog box, select the appropriate code page conversion
tables.
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Select the code page tables that correspond to the languages that you want to display on
the Integration Services Console computer.

b. Click OK to close the Advanced Regional Options dialog box.

5 In the Regional Options dialog box, click Apply to apply the changes you made.

6 Click OK to close the Regional Options dialog box.

For more information on Windows Regional Options, refer to the Windows 2000
documentation.

Enabling Regional Options in Windows XP

➤ To enable the Regional and Language Options in Windows XP:

1 In the Windows taskbar, select Start > Control Panel and double-click Regional and Language Options.

The Regional Options tab of the Regional and Language Options dialog box is displayed.

2 In the Standards and formats frame, from the drop-down list, select the appropriate language to use for
formatting items such as numbers, currencies, time, and dates.

In most cases, you set this language to match your location.

3 Click the Languages tab and click the Details button.

The Text Services and Input Languages dialog box is displayed.

4 In the Installed services frame, click Add.

5 In the Input Languages list, select the language that you want to add and select the check box for the type
of text service you want to install.

For example, you may select Cyrillic to display Russian characters or Simplified Chinese and
Traditional Chinese to display Chinese characters.

6 If the languages that you need do not appear in the Input Languages frame, or if you want to add a specific
code page to a language, click the Advanced tab and perform the following tasks:

a. In the Code page conversion tables frame, select the appropriate code page conversion
tables.

Select the code page tables that correspond to the languages that you want to display on
the Integration Services Console computer.

b. Click Apply.

7 Click OK to close the Regional Language and Options dialog box.

For more information on Windows Regional Language and Options, refer to the Windows XP
documentation.
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Enabling Regional Options in Windows 2003

➤ To enable the Regional and Language Options in Windows 2003:

1 In the Windows taskbar, select Start > Control Panel and double-click Regional and Language Options.

The Regional Options tab of the Regional and Language Options dialog box is displayed.

2 In the Standards and formats frame, from the drop-down list, select the appropriate language to use for
formatting items such as numbers, currencies, time, and dates.

In most cases, you set this language to match your location.

3 Click the Languages tab and click the Details button.

The Text Services and Input Languages dialog box is displayed.

4 In the Default input language drop-down list, select the installed input language to use.

5 If the language you want does not appear in the Default input language drop-down list, click Add in the
Installed services frame.

The Add Input Language dialog box is displayed.

6 In the Input languages list, select the language that you want to add.

7 In the Keyboard layout/IME list, select the check box for the type of text service you want to install and
click OK.

For example, you may select Cyrillic to display Russian characters or Simplified Chinese and
Traditional Chinese to display Chinese characters.

8 Optional: If the languages that you need do not appear in the Add input languages dialog box, or if you
want to add a specific code page to a language, perform the following steps:

a. Click Cancel to close both the Add input languages dialog box.

b. Click Cancel to close the Text Services and Languages dialog box.

c. In the Regional and Language Options dialog box, click the Advanced tab.

d. In the Code page conversion tables frame, select the appropriate code page conversion
tables.

Select the code page tables that correspond to the languages that you want to display on
the Integration Services Console computer.

e. Click Apply.

9 Click OK to close the Regional Language and Options dialog box.

For more information on Windows Regional Language and Options, refer to the Windows 2003
documentation.
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Manually Updating the Environment on Windows Systems
During installation, you can decide to update operating system environment variables. If you
decided not to update the environment variables, you must update them manually or the
Integration Services software will not work.

Table 14 lists the environment variables required to run the Integration Services client software
on Windows, or to run the server software on Windows:

Table 14 Environment Variables Required for Integration Services on Windows  

Name Purpose and Default Setting

ISHOME Specifies the directory where the Integration Services software is installed.

C:\Hyperion\AIS

ARBORPATH Specifies the directory where the Essbase libraries are installed.*

C:\Hyperion\AIS

HYPERION_HOME Specifies the directory where the common Hyperion components are installed.

C:\Hyperion

ISLOADINFO Specifies a directory location for the reject files created during a member load or data load.

C:\Hyperion\AIS\loadinfo

PATH Specifies the list of directories to search for software programs and libraries.

The default setting is the current PATH list, with the following entries added to the end of the list:

C:\Hyperion\AIS\bin;

%HYPERION_HOME%\common\Merant\ODBC\5.0\Drivers; †

TEMP Specifies a directory for temporary files.

C:\Temp 

*If Essbase is installed, set this variable to the directory where that product is installed. The default directory is C:\Hyperion
\EssbaseServices.
†The Merant\ODBC\5.0\Drivers directory is required only if you install the ODBC drivers provided with Integration Services.

On Windows, update the environment variables using the System Properties dialog box from
the Windows Control Panel.

When updating the PATH variable, be sure to add the new directory entries to the end of the
existing list. Do not delete existing directory entries from the list unless they are duplicates.

If you choose to update the environment variables during installation, the Integration Services
installation program, setup, updates the environment variables. It detects whether Essbase is
installed on the same machine and takes the appropriate action:

● The setup program always creates the ISHOME system variable and points it to the
directory where Integration Services is installed. By default, the value of ISHOME is:

   C:\Hyperion\AIS
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● If Essbase is installed on the same machine, setup does nothing to the ARBORPATH
variable, and Integration Services shares the Essbase DLL files in ARBORPATH\bin.

The following topics provide the upgrade procedures specific to each Windows platform:

● “Updating Environment Variables on Windows 2000” on page 107

● “Updating Environment Variables on Windows XP” on page 108

● “Updating Environment Variables on Windows 2003” on page 109

Updating Environment Variables on Windows 2000
On Windows 2000 systems, update environment variables using the System Properties dialog
box, located in the Control Panel.

Note:

You must have system administrator privileges to create a system variable; otherwise, you can
only create a user variable.

➤ To manually update environment variables on Windows 2000:

1 On the Windows desktop, click Start.

2 Select Settings > Control Panel.

3 In the Control Panel window, double-click System.

4 In the System Properties dialog box, select the Advanced tab.

5 In the Advanced tab, click Environment Variables.

6 In the Environment Variables list box, perform one of the following steps:

● To create a new variable, in the Systems variables group box, click New.

● To edit a variable, in the Systems variables list box, select the variable you want to change,
and click Edit.

7 In the Variable Name text box, type the name of the variable you want to add; for example, ISHOME.

8 In the Variable Value text box, enter the value that you want to add; for example, for the ISHOME variable,
type C:\Hyperion\AIS if you installed Integration Services in the default destination directory.

9 Click OK.

The variable and its value are displayed in the System Variables list box.

10 Repeat Step 6 through Step 9 for each of the environment variables listed in Table 14.

Caution!

When updating the PATH variable, be sure to add the new directory entries to the end of the
existing list. Do not delete existing directory entries from the list unless they are duplicates.

11 Click OK to close the System Properties dialog box.
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Before you use Essbase Integration Server, either log off Windows and log in again, or restart
the computer to apply the changes you made to the environment.

Updating Environment Variables on Windows XP
On Windows XP systems, update environment variables using the System Properties dialog box,
located in the Control Panel.

Note:

You must have system administrator privileges to create a system variable; otherwise, you can
only create a user variable.

➤ To manually update environment variables on Windows XP:

1 On the Windows desktop, click Start.

2 Select Control Panel > Performance and Maintenance, and then click System.

The System Properties dialog box is displayed.

3 In the System Properties dialog box, select the Advanced tab.

4 In the Advanced tab, click Environment Variables.

5 In the Environment Variables list box, perform one of the following steps:

● To create a new variable, in the Systems variables list box, click New.

● To edit a variable, in the Systems variables list box, select the variable that you want to
change, and click Edit.

6 In the Variable Name text box, type the name of the variable that you want to add; for example, ISHOME.

7 In the Variable Value text box, enter the value that you want to add or modify; for example, for the
ISHOME variable, type C:\Hyperion\AIS if you installed Integration Services in the default destination
directory.

8 Click OK.

The variable and its value are displayed in the System Variables list box.

9 Repeat Step 6 through Step 8 for each of the environment variables listed in Table 14 on page 106.

Caution!

When updating the PATH variable, be sure to add the new directory entries to the end of the
existing list. Do not delete existing directory entries from the list unless they are duplicates.

10 Click OK to close the System Properties dialog box.

Before you use Essbase Integration Server, either log off Windows and log in again, or restart
the computer to apply the changes that you made to the environment.
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Updating Environment Variables on Windows 2003
On Windows 2003 systems, update environment variables using the System Properties dialog
box, located in the Control Panel.

Note:

You must have system administrator privileges to create a system variable; otherwise, you can
only create a user variable.

➤ To manually update environment variables on Windows 2003:

1 On the Windows desktop, click Start.

2 Select Control Panel and then click System.

The System Properties dialog box is displayed.

3 In the System Properties dialog box, select the Advanced tab.

4 In the Advanced tab, click Environment Variables.

5 In the Environment Variables list box, perform one of the following steps:

● To create a new variable, in the Systems variables list box, click New.

● To edit a variable, in the Systems variables list box, select the variable that you want to
change, and click Edit.

6 In the Variable Name text box, type the name of the variable that you want to add; for example, ISHOME.

7 In the Variable Value text box, enter the value that you want to add or modify; for example, for the
ISHOME variable, type C:\Hyperion\AIS if you installed Integration Services in the default destination
directory.

8 Click OK.

The variable and its value are displayed in the System Variables list box.

9 Repeat Step 6 through Step 8 for each of the environment variables listed in Table 14 on page 106.

Caution!

When updating the PATH variable, be sure to add the new directory entries to the end of the
existing list. Do not delete existing directory entries from the list unless they are duplicates.

10 Click OK to close the System Properties dialog box.

Before you use Essbase Integration Server, either log off Windows and log in again, or restart
the computer to apply the changes that you made to the environment.
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Starting the Windows Task Scheduler Service
Integration Services uses the Task Scheduler service for the Windows platforms to perform
scheduled member and data loads. To allow loads to be scheduled, you must ensure that both
of these conditions are met:

● The Task Scheduler service must be started on the computer that runs Essbase Integration
Server.

● The Task Scheduler service is enabled to start automatically each time the computer that
runs Essbase Integration Server is started.

➤ To start the Windows 2000 Task Scheduler service:

1 On the Windows desktop, click Start.

2 Select Settings > Control Panel.

3 In the Control Panel window, double-click the Administrative Tools icon, and then double-click the
Services icon.

4 In the list of services, locate Task Scheduler and verify that the entry in the Status column is Started and
the entry in the Startup type column is Automatic.

If you must change one or both entries, this is the process:

a. Double-click Task Scheduler.

b. In the Task Scheduler Properties dialog box, select the General tab.

c. Under Startup type, select Automatic.

d. To start the service, in the Task Scheduler Properties dialog box, click Start.

➤ To start the Windows XP Task Scheduler service:

1 On the Windows desktop, click Start.

2 Select Control Panel.

3 In the Control Panel window, click Performance and Maintenance.

4 In the Performance and Maintenance window, click Administrative Tools.

5 In the Administrative Tools window, double-click the Services icon.

6 In the list of services, locate Task Scheduler and verify that the entry in the Status column is Started and
the entry in the Startup type column is Automatic.

If you must change one or both entries, this is the process:

a. Double-click Task Scheduler.

b. In the Task Scheduler Properties dialog box, select the General tab.

c. Under Startup type, select Automatic.

d. To start the service, click Start in the Task Scheduler Properties dialog box.
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➤ To start the Windows 2003 Task Scheduler service:

1 On the Windows desktop, click Start.

2 Select Control Panel.

3 In the Control Panel window, click Administrative Tools.

4 In the Administrative Tools window, double-click the Services icon.

5 In the list of services, locate Task Scheduler and verify that the entry in the Status column is Started and
the entry in the Startup type column is Automatic.

If you must change one or both entries, this is the process:

a. Double-click Task Scheduler.

b. In the Task Scheduler Properties dialog box, select the General tab.

c. Under Startup type, select Automatic.

d. To start the service, click Start in the Task Scheduler Properties dialog box.

Creating Database User Aliases and Synonyms
When using the sample application, you must connect to TBC_MD as user TBC unless you set
up your user name as an alias or synonym for TBC.

● On SQL Server and Sybase, make your login user name an alias of TBC.

● On DB2 and Oracle, log in with your user name and password, and create synonyms that
map to the tables in TBC_MD.

This user alias or table synonym enables you to access a table that is qualified by TBC because
it was created by the TBC user; for example, TBC.MO_INFO in the TBC_MD OLAP Metadata
Catalog.

For more information, see the documentation for the RDBMS you are using.

Troubleshooting Installations
If you encounter problems after installing Integration Services, check the troubleshooting list in
Table 15 for solutions:

Table 15 Installation Troubleshooting List  

Problem Solution

Server will not start Check the environment variable settings.

Client will not start Check the environment variable settings.

Long wait or no response from server Check to see if Essbase Integration Server or the server
computer is running.
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Problem Solution

Cannot log in to OLAP Metadata Catalog ● Passwords are often case-sensitive; ensure the Caps
Lock key is disabled.

● Ensure you are using the correct user name and
password. Use the same user name and password that
were used to create the catalog or an alias of that user
name.

● Check the environment variable settings for the database
client software on the server.

● Check the environment variable and connection settings
for ODBC on the server.

● Check the ODBC data source configuration for the
catalog on the server.

Cannot log in to data source See solutions in this table for logging on to OLAP Metadata
Catalog.

Cannot log in to Essbase Integration Server and
Essbase Server inside a firewall from an Essbase
Integration Services Console outside a firewall

You must log in to the Essbase Server using names or IP
addresses for the Integration Server and Essbase Server
(provided to you by your system administrator) that are
accessible from both sides of the firewall.

Cannot see a catalog in SQL Server If you receive a message that OM_INFO is missing, be sure
to configure the ODBC Data Source Name (DSN) to use the
catalog database.

Also, run ivtestlib to verify that the environment is set
to run the correct odbc driver file. For example, run
ivtestlib and paste the path and file name that you
defined for Driver= in the odbc.ini file.

Most problems with Integration Services are the result of connection difficulties and improperly
set environment variables. For more information on diagnosing connection problems, see the
Essbase Integration Services System Administrator's Guide.

For information on setting environment variables, see “Manually Updating the Environment
on Windows Systems” on page 106.

The SQL Server ODBC driver may time out during a call to an SQL Server database, particularly
during a data load. If this occurs, try again when the database is not busy. Increasing the driver
time-out period may avoid this problem. For more information, see the ODBC documentation.

Caution!

If you install Integration Services on the same computer where Essbase is installed, and if you
later remove Essbase, you must change the environment to adjust for the removal of Essbase.
Otherwise, Integration Services will not work. For information on the operating environment
and how to change it, see “Manually Updating the Environment on Windows Systems” on page
106.
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This chapter describes the procedures for uninstalling the Essbase software.

Removing Software from Windows Systems
Integration Services software is registered with Windows systems so that it can be uninstalled.

If you want to preserve your existing sample database, OLAP Metadata Catalog, and the OLAP
models and metaoutlines stored in the catalog from a previous release, you should first back up
your Integration Services environment to a separate location. You can then uninstall Integration
Services.

Note:

If you are currently running Essbase Integration Server as a Windows service, you must stop the
service before beginning the uninstall process.

➤ To remove Integration Services software from Windows systems:

1 Click Start on the Windows desktop, and select Programs > Settings > Control Panel.

2 In the Control Panel window, double-click Add/Remove Programs.

3 In the Add/Remove Programs Properties dialog box, select Essbase Integration Services and click Add/
Remove.

4 Confirm that you want to remove the Integration Services software.

On Windows, removing Integration Services removes the ISHOME system variable but does
not remove the following items:

● The ARBORPATH system variable

● Integration Services directory entries in the Path system variable
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Note:

If you install and uninstall Integration Services multiple times on a Windows platform, check
your system path file, and remove duplicate directory entries.

● Files created after the installation, such as olapisvr.log

● Obsolete items on the Windows Start menu related to Integration Services

Removing or Reinstalling the Windows Service
The Integration Services installation program automatically installs the Windows service for
Integration Server. You can remove the Windows service. You can also reinstall the Windows
service if you previously removed it. The Windows service must be installed on the same
computer as Integration Server.

➤ To remove the Windows service for Essbase Integration Server, at the command prompt, type:

olapisvc -u 

➤ To reinstall the Windows service for Essbase Integration Server, at the command prompt, type:

olapisvc -i 

114 Uninstalling Integration Services



11
Upgrading Integration Services

In This Chapter

Platform Support and Hardware Requirements ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 115

Upgrading Issues... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 117

Migrating Existing OLAP Metadata Catalogs... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 119

Completing the Upgrade ... . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 120

This chapter describes the steps necessary to upgrade from earlier versions of Integration Services
to the current release.

Note:

Before you install the current release of Integration Services, back up all your Integration Services
files from earlier versions. Backing up your files will enable you to revert to an earlier release
level if you encounter problems during the installation process.

Note:

Before you install the current release of Integration Services, we recommend that you uninstall
the previous release.

If you are upgrading from a previous release of Hyperion products, note the following supported
upgrade paths:

● 9.2.0.3 to 9.3.1

● 9.3.0.x to 9.3.1

If you are using a release prior to 9.2.0.3, you must first upgrade to one of the versions noted
above, and then upgrade to 9.3.1. Upgrading from 9.2 releases prior to 9.2.0.3 will be supported
in an upcoming service pack.

Platform Support and Hardware Requirements
Some earlier platform versions that were supported by previous Integration Services releases are
not supported in this current release. For details on current platform support, see .
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To use the current Hybrid Analysis features, you must install the current version of Essbase.
Integration Services supports the server and client platforms described in Chapter 3, “Planning
the Installation.”

Data Source Connectivity
To accommodate ODBC connections between Integration Server, relational data sources, and
OLAP Metadata Catalog, Integration Services provides DataDirect Version 5.0 ODBC drivers
for Windows 2000, Windows XP, Windows 2003, AIX, HP-UX, Solaris, and Linux. For details
on current platform support, see Essbase Integration Services ODBC Support Matrix.

The Oracle Call Interface (OCI) Protocol is also supported and is required if your installation
uses Oracle onames instead of tnsnames.

Integration Server manages ODBC connections to one or more relational data sources and to
OLAP Metadata Catalog, as illustrated in Figure 2 on page 11.

Supported ODBC Drivers
Integration Services provides Version 5.0 DataDirect ODBC drivers on the operating systems
listed for each supported RDBMS. Oracle Call Interface (OCI) Protocol is also supported. For
a complete listing of supported ODBC drivers per database and operating system, see Essbase
Integration Services ODBC Support Matrix. Hyperion Solutions has tested only the listed database
configurations with the current release. Contact the provider of the driver if you have problems
with your configuration.

Note:

ODBC drivers used with Integration Services must be thread-safe. All drivers in the matrix are
thread-safe. HP-UX requires kernel-threads, Solaris requires Solaris threads, and AIX requires
kernel-threads with pthread API.

JRE Files
Integration Services requires Java Runtime Environment (JRE) files. For Windows systems,
Integration Services Installation automatically installs JRE files in HYPERION_HOME\common
\JRE\ to avoid conflicts with other versions of JRE that you may have installed on the same
computer.

Supported JDBC Drivers for XML Import and Export
JDBC drivers are required to support the XML Import/Export functionality in Integration
Services.

JDBC Type 1 is installed when you install the Java Runtime Environment (included as an option
in the Windows installation).
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With the exception of Oracle and Teradata, JDBC Type 1 is compatible with all RDBMSs
supported by Integration Services. For information on supported JDBC drivers, see Essbase
Integration Services ODBC Support Matrix.

Upgrading Issues
If you are upgrading to Integration Services Release from a previous release, you should assess
several system environment and data migration issues before installing the new software. The
following topics explain and recommend solutions for migration issues:

● “Preserving Existing ODBC Drivers” on page 117

● “Verifying Path Variable Settings” on page 118

● “Migrating Existing OLAP Metadata Catalogs” on page 119

Read the topics to assess migration issues that may affect your Integration Services installation.
Note that the following tasks cannot be completed until after you install Integration Services:

● On all systems, you cannot migrate existing OLAP Metadata Catalogs until the installation
process is complete and the SQL scripts that you need are created (see “Upgrading OLAP
Metadata Catalogs Manually” on page 65).

Default Directory for Windows
The default directory for Windows installations is

C:\Hyperion\AIS

Preserving Existing ODBC Drivers
Integration Services architecture concentrates ODBC driver configuration solely on the
computer that runs Integration Server. With this architecture, you do not have to configure
ODBC drivers for client computers that run Integration Services Console or worry about
upgrading ODBC drivers on clients.

Note:

For details on current ODBC driver support, see Essbase Integration Services ODBC Support
Matrix.

If you use the DataDirect ODBC drivers supplied with earlier releases of Integration Services,
you may want to preserve the older drivers for compatibility with other applications. In general,
however, you should upgrade the ODBC drivers to the versions provided with the latest release
of Integration Services.

The directory structure provided with Integration Services enables you to retain and continue
to use older versions of DataDirect drivers without the need to install Integration Services to a
new location.
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Essbase and Integration Services on Same Computer
If both Essbase Server and Integration Services are installed on the same computer and the same
user ID starts both Essbase Server and Integration Services, you must set the Java environment
variables associated with both Essbase Server and Integration Services. This step is necessary to
ensure that the correct version of Java is referenced depending on whether you are logged on as
the Essbase user or the Integration Services user.

Verifying Path Variable Settings
If you are upgrading from an earlier release, allow the setup.exe program to update the
environment variables. After the installation is complete, however, check that the path variables
are set properly for the system configuration.

Windows Path Settings

● If you install Integration Services on a computer that also runs Essbase, verify that the
ARBORPATH environment variable is set correctly:

Set ARBORPATH to the installation directory for Essbase. The default location for Essbase
is C:\Hyperion\EssbaseServices.

● If you install Integration Services on a computer that is not running Essbase, verify that the
ARBORPATH environment variable is set as follows:

   ARBORPATH=ISHOME 

(See “Completing Additional Steps on Windows Systems” on page 26.)

For more information about viewing and manually editing the paths and other environment
variables on Windows systems, see “Manually Updating the Environment on Windows Systems”
on page 106.

Upgrading Tips
To make certain that your upgrade to the current release of Integration Services from an earlier
version is performed smoothly, keep in mind the following tips:

● Integration Services requires that you install Essbase on a computer on the network.

● If Essbase Server is not already installed on the network, install it before beginning the
installation of Integration Services.

● The current release of Integration Services also supports the most current versions of
previous Essbase. However, to use new Integration Services features, you must install the
latest release of Essbase.

● If you are upgrading Integration Services on AIX, and if you do not plan to install the latest
release of Essbase, you should install the latest IBM C++ runtime libraries on AIX before
installing Integration Services.
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● After Oracle's Hyperion® Essbase® – System 9 is installed, you must enable at least one
instance of Essbase Server on the network to work with the Integration Services software.

● If you are upgrading from Release 2.0 or earlier of Integration Services, it is recommended
that you install in the $HOME/Hyperion/EssbaseIntegrationServices directory
structure. If, however, you plan to use the existing installation directory structure, be sure
to run the uninstall program, essuninst.sh, to remove all Integration Services files
completely, including hidden (dot) files.

Migrating Existing OLAP Metadata Catalogs
If you have an existing OLAP Metadata Catalog from an earlier Integration Services release, it
is highly recommended that you upgrade the Catalog before using the OLAP Metadata Catalog
with the current release of the software. The OLAP Metadata Catalog can be used by some
previous versions of Integration Services (6.5.1 and later), but it is not advised.

Note:

Any new OLAP Model or Metaoutline created in the new version of Integration Services should
not be opened or saved by previous versions of Integration Services because new properties may
not be handled properly.

You cannot upgrade an existing OLAP Metadata Catalog until you complete the installation
process. The Integration Services setup program installs the scripts that are needed for the
upgrade (see “Upgrading OLAP Metadata Catalogs Manually” on page 65).

Caution!

If you installed the sample application from a previous release of Integration Services, you should
back up your existing sample database, OLAP Metadata Catalog, and the OLAP models and
metaoutlines stored in the catalog. You can then upgrade your existing catalog to be compatible
with the current release of the software. You cannot, however, store new sample OLAP models
and metaoutlines in your previous catalog.

To upgrade an existing OLAP Metadata Catalog, perform the following tasks:

● Complete the upgrade steps for the existing OLAP Metadata Catalog described in
“Upgrading OLAP Metadata Catalogs Manually” on page 65.

● When connecting to the relational database, use the same user name and password that you
used when you created the original OLAP Metadata Catalog. This procedure adds new tables
to the OLAP Metadata Catalog or alters existing tables in the catalog without changing any
existing data.
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Caution!

After you upgrade an OLAP Metadata Catalog, you cannot roll back to the previous version.
The new version of OLAP Metadata Catalog is not compatible with previous releases of
Integration Services. In addition, do not attempt to use the current OLAP Metadata Catalog
with previous releases of Integration Services; such an attempt can result in corrupted catalog
data.

Completing the Upgrade
To complete the upgrading of Oracle's Essbase® Integration Services, see Chapter 6, “Post-
Installation Tasks,” Chapter 5, “Configuring Data Sources,” and Chapter 7, “Creating,
Upgrading, and Deleting OLAP Metadata Catalogs.” To work with the sample application, see
Chapter 8, “Setting Up the Sample Applications.”

For detailed information about installed files, directories, environment changes made by the
installation program, and uninstalling the software, see Chapter 9, “Completing Advanced
Installation Tasks,” and Chapter 10, “Uninstalling Integration Services.”

Tip:

During updating, configuration, and testing, keep a list of all user names and passwords that
you use to create or modify the system, including the applications with which they are associated
and their purpose.
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